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cHAPTER 1

StarOffice Documentation and Help

There are different ways of obtaining information about working with StarOffice:

» The StarOffice User's Guide - This contains most of the answers to questions
about working with StarOffice. You can find an overview of the structure and
content of the StarOffice User's Guide starting on page 19.

« StarOffice Help - You can get detailed answers to all questions at any time by
pressing (F1), opening the Help menu or clicking the Help buttons. You can
find information on using the StarOffice Help starting on page 22.

» Through the Internet, you can find further information, support newsgroups
and the latest news about StarOffice at www.sun.com.

Using this Guide

This User's Guide is designed for users who are already familiar with the basic
functions of their computer.

The User's Guide primarily describes the functions available in the Windows
version of StarOffice. There may be differences in certain functions on other oper-
ating system platforms. If functions described here are not available on your plat-
form, this is a system-related limitation caused by the platform you are using.
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Structure of this Guide

Chapter 1: StarOffice Documentation and Help

Introduction to the User's Guide and to StarOffice Help.
Chapter 2: Working With StarOffice

Overview of general topics of relevance to the whole of StarOffice.
Chapter 3: Creating Text Documents With StarOffice Writer
Instructions for word processing in StarOffice Writer.
Chapter 4: Creating Spreadsheets With StarOffice Calc
Instructions for the use of spreadsheets in StarOffice Calc.
Chapter 5: Creating Presentations With StarOffice Impress
Instructions for presentations in StarOffice Impress.

Chapter 6: Creating Drawings With StarOffice Draw
Instructions for drawing in StarOffice Draw.

Chapter 7: Advanced Tips for Working With StarOffice

Instructions for working with data sources, the gallery and copying between
different program modules.

In Appendix you will find other information, and at the end of the manual is an
alphabetical index.
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Icons and Conventions

There are three icons used to call your attention to additional helpful information.

The "Important!" icon points out important information regarding data and
system security.

The "Note" icon points out extra information: for example, alternative ways to
reach a certain goal.

The "Tip" icon points out tips for working with the program in a more efficient
manner.

The names of menu commands, icons, dialogs and other control elements of
StarOffice are hereafter printed in bold.

To delineate the steps for opening dialogs, a special shorthand is used. For
example, when you read "choose Tools - Options - StarOffice - User Data", this
means that you first choose the Tools menu on the menu bar, choose Options
from the submenu that then appears, then choose StarOffice and finally User
Data.
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Using the StarOffice Help

Different kinds of help are available in StarOffice. You can choose step-by-step
instructions with full references in the contents of the StarOffice Help, Help Tips

that pop up next to the mouse pointer, or, similar to Help tips, more detailed
explanations in Extended Tips.

The StarOffice Help

To access the StarOffice Help, use the Help menu or click the Help buttons in the
individual dialogs.

B StaiDffice Help - Help about StarOffice Writer

IHeIp about Star Office Wiriter j

-0 RSB

Contents | Irdesx I Fitd I Bookmarks | =

. Welcome to the StarOffice Writer Help i

@ Help about Star Office Math
@ Help about StarOffice Impress

g :::E :::E: z::g::z E:’E‘” Help about StarOffice Writer

) - Instructions for Using StarOffice Writer
@ Help about Star Dffice fasic The StarOffice Writer Functions

Menus

Toolbars

Text Document Shortcut Keys

Charts in StarOffice

Help about the Help
The StarOffice Help Window
Help Agent, Tips and Extended Tips
Index - Keyword Search in the Help
Find - The Full-Text Search
Managing bookmarks
Contents - The Main Help Topics

[ |we] <]

The StarOffice Help is context-sensitive. This means that, to get help about a
spreadsheet in StarOffice Calc, you first open a spreadsheet and only then look for
help, or select the help you need from the combo box at the top of the Help

window. The combo box at the top of the Help window sets the search function to
the current section.
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Tips

Tips should always be switched on (in the Help menu, Tips should be marked).
B¢

= nser]

Then, for example, when you let the mouse pointer rest on an icon, you will see its
name displayed. You can see tips in a lot of other places in StarOffice besides. For
example, when you scroll through a table, the tip shows you the row or column.

Turning tips on and off

» Choose Help - Tips.

Extended Tips

At least for the first few weeks you use StarOffice, we recommend that you switch
on the Extended Tips.

‘@H [ o

Long—click here to open the floating toolbar
containing warious functions for inserting frames,
graphics. tables, and other objects. A short click
activates the tool shown as ican.

This gives you a brief description of each item on the screen when you allow the
mouse pointer to rest there for a moment.
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Turning extended tips on and off

= Choose Help - Extended Tips to turn extended tips on and off. The
command is marked if the Extended Tips function is switched on.

L}f} = Press (Shift)(F1) to turn Extended Tips on temporarily. The pointer

" turns into the Extended Tips pointer. You now see the Extended Tips for
any element on the screen where you move the pointer. As soon as you
click with the mouse or press a key, it turns back into the normal mouse
pointer.

Help Agent

| %| When you perform certain actions in StarOffice, the Help Agent
; _ automatically appears. This is a small window in a corner of the
B document.

The Help Agent normally remains visible for 30 seconds. When you click it, it is
replaced by a help window providing some helpful advice about the current topic.

If you repeatedly ignore or close a Help Agent dealing with the same topic instead
of clicking it, it will not appear again for this topic. Resetting the Help Agent
restores it to the way it was when StarOffice was first installed.

Turning the Help Agent on and off

= Choose Help - Help Agent if you want the Help Agent to appear. If the
command is marked, the Help Agent is automatically displayed when you
perform certain actions in StarOffice.

= In Tools - Options - StarOffice - General, you can activate and reset the Help
Agent and set its display duration.
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CHAPTER 2

Working With StarOffice

This chapter starts with a general explanation of the most common control features
in StarOffice, such as toolbars, floating toolbars and dockable windows.

This is followed by information on functions that can be used in all, or nearly all,
program modules of StarOffice.

The User Interface

StarOffice provides not only the usual control elements found in other applica-
tions, such as menus and icons, but a host of other special features besides. For
example, many of the special StarOffice features can be accessed via a context
menu, opened by right-clicking on the selected objects. Other user-friendly func-
tions are available by dragging and dropping with the mouse.

Starting StarOffice

Once you have installed the program (see the separate setup guide), you will find
the StarOffice 6.0 group on the Windows Start menu under Programs. To create a
blank text document in StarOffice Writer, click Text Document. For a blank
spreadsheet in StarOffice Calc, click Spreadsheet, and so on.

When working under Windows, you can use the StarOffice 6.0 Quick-
starter. On the Windows task bar you will find an icon that you can either
double-click or right-click to open its context menu.

Right-clicking Quickstarter opens a submenu from which you can open a new,
blank document. Double-click Quickstarter to open the Templates and Docu-
ments dialog (see page 33).
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The StarOffice Writer Window

A text document is displayed and edited in the StarOffice Writer window. A
spreadsheet, presentation or drawing is displayed in a very similar window,
except the menus and icons change automatically depending on the context.
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The Title Bar

The title bar shows the name of StarOffice and usually the file name of the current
document. If you gave the document a title in File - Properties - Description , you
will see this instead of the file name.

The Menu Bar

At the top of the StarOffice window is the menu bar. Point with the mouse to a
command on the menu bar and press the left mouse button. The menu opens,
allowing you to choose a command from the submenu by clicking it.

You can also access the menu bar from the keyboard, by pressing the (Alt) key.

The menus are organized into basic functions. On the Edit menu, for example, are
the functions you need to edit the current document (cut, copy, paste, undo
changes and so on), whilst on the View menu are functions that allow you to
control your view of the elements displayed on the screen.

The commands, which can be used for editing, viewing, sequencing, formatting
and printing, etc. a document or its contents, can only be called up if the docu-
ment is open and acitve. Active means, in this case, that the document has to be
in front of any others on the screen. If you want the commands to correspond to
an object in the document, then that object has to be selected.

The menus are context sensitive, this means that those menu commands will be
available that are relevant to the work being currently carried out. If the cursor is
located in a text, then all of those menu commands are available that are needed
to edit the text. If, for example, you have selected graphics in a document, then
you will see all of the menu commands that can be used to edit graphics.

You now see only the menu entries that can also be started. The other inactive
menu items are hidden. If you choose Tools - Options - StarOffice - View you can
mark the Inactive Menu Entries field if you wish to see the inactive menu entries
as gray entries.

In StarOffice you can change and adapt the menu bar the way you like. You can
also modify many of the toolbars and the status bar (Tools - Configure, see page
401).
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The Toolbars

Below the menu bar is the function bar. This bar contains icons for several impor-
tant commands and functions that you can use in StarOffice - to open a document
or print the current document, for example.

il Immediately above the document is the object bar. This offers features that
are always appropriate to the current context. For example, if you select a
piece of normal text, you will see different icons than if the cursor is posi-
tioned in a bulleted list or in a text table. If the cursor is positioned in a
bulleted list within a text table, for example, you can toggle the object bar
with an icon at the far right of the object bar.

On the left edge of the document is the main toolbar. This varies depending on the
document type (text, spreadsheet, presentation, drawing or formula).

Other toolbars such as the option bar and color bar will be described later.

It is easy to modify the toolbars. For example, if you would rather have the main
toolbar on the right edge of the document instead of on the left, simply hold down
(Ctrl) and drag it there. If you want to change the sequence of icons on a bar, you
can drag the icons to the new location whilst pressing the (Alt) key (in the
Windows version). You can find more information about adapting StarOffice
starting on page 401.

Many icons open what we call floating toolbars. These icons have small triangles
to indicate that you can open the floating toolbar with a long click. These icons
behave differently depending on whether you do a short or long click on them (see
page 28).

Using Floating Toolbars

The Insert icon is at the top of the main toolbar of a text document. Do a long click
on this icon. This opens a floating toolbar containing further icons.

=
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You now have a choice: Either click the icon that you want to activate, or seize the
floating toolbar by its title bar and drag it away from the main toolbar while
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holding down the mouse button (You first have to release the mouse button, other-
wise you cannot seize the title bar with the mouse).

Now look at the icon at the top of the main toolbar with which you opened the
floating toolbar. You will see that the icon you used before is still there. If you now
click the Insert Graphics icon, you will see that icon at the top of the main toolbar
instead. A short click opens the directly visible function, whereas a longer click
opens the floating toolbar again.

The document window

At the top left hand edge of the document window are the toolbars that you need
in your work, and that vary depending on the document type and context. At the
bottom edge is the status bar.

The status bar contains different fields displaying information appropriate to the
type of document. Some of these fields give you access to special functions, either
by double-clicking or by opening the relevant context menu. For more detailed
explanations, refer to StarOffice Help.

Docking windows

Some windows in StarOffice are dockable windows, e.g. the Stylist, the Navigator
and the Gallery. You can move these windows, re-size them or dock them to an
edge. On each edge you can dock several windows on top of or alongside each
other; then, by moving the border lines, you can change the relative proportions of
the window.

To undock and re-dock, double-click in the window while pressing Ctrl. Double-
click a vacant area of the window; in the Stylist double-click a gray part of the
window, e.g. next to the icons.

You can hide or show the window with the arrow button. The second button
switches between a fixed and floating state. In the floating state, the window floats
above the workplace so that the windows below it are partially covered. Switch to
the fixed state to display the docked window next to the workplace.
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If the window is docked to the left of the workplace, the following buttons appear
depending on the state:

Show
ﬂ A hidden window can be shown by clicking the arrow button.
Hide
ﬂ Click the arrow button to hide a window.
Stick
ﬁ Click this button to fix a floating window.
Floating
ﬂ Click this button to change a fixed window to a floating window.

On any window edge where another window is docked you will see two buttons
which allow you to show, hide or fix the window.

= If you use the arrow button on the window edge to show the other window, the
window will remain visible until you manually hide it again (with the same
button).

= If you show the window by clicking the window border, you activate theAuto-
Hide function. Hiding is then automatic.

Seize a window by the title bar or by a vacant area and move it across the screen.
Hold down the (Ctrl) key while moving it to dock the window to the edges.

If you want to dock another window to one which is already docked, you can have
them one on top of the other or side by side. Note the change in the window edge.
This shows you where the window will dock and how big it will be.
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Opening and Saving Documents

There are various ways of loading or opening documents. For example, you can
use the Open dialog and the Templates and Documents dialog.

Opening Documents

2 To open an existing document that was saved on the hard drive or on a
disk, you have several possibilities. You can either choose File - Open, click
the Open File icon on the function bar, or use the Ctrl+O shortcut keys.

Now you see the Open dialog. Under Windows, a system dialog is automatically
displayed when opening and saving StarOffice documents. Choose Tools -
Options - StarOffice - General and mark Use StarOffice dialogs. Then you will
see the StarOffice dialogs shown in this guide.

Open
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This dialog is described in detail in the StarOffice Help. However, here are a few tips:

You can change the size of the dialog by dragging the borders of the dialog
with your mouse.

Click the Default Directory icon to go straight to your work directory. To
define your work directory, choose Tools - Options - StarOffice - Paths.

You can long-click or short-click the Up One Level icon. A short click takes
you one directory higher. A long click opens a submenu with a choice of
superordinate directories.

I® |

To only see files containing a certain name, enter the name with wildcards in
the File name combo box and press Enter. If you use *.txt for example, only
the files having .txt at the end of their names will be displayed. If you use s*
all names beginning with the letter s will be displayed.
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The Templates and Documents Dialog

The Templates and Documents dialog can be regarded as a kind of command
center for StarOffice documents. It provides easy access to your work directory
and to the supplied sample documents. Here you can find all document templates
- both the supplied ones and those you have created yourself.

To open the dialog, choose File - New - Templates and Documents or press
Shift+Ctrl+N. In Windows, double-click the StarOffice 6.0 Quickstarter icon on the
task bar.

Templates and Documents - Samples x|
+ & & g
Title:
& (] Drawings
(23 Formulas

Mew Document [Z] Presentations
[Z] Spreadsheets
[Z] Text Documents

-

Templates

2

My Documents

3

samples

Organize.. | Edit: | et Cancel | Help |

The dialog offers the following areas, which you can select by clicking in the left field:
» New Document - This is one way of creating a new, empty document.

» Templates - Choose from the many ready-to-use document templates we have
prepared for you.

» My Documents - A quick route to the documents in your work directory. To
define your work directory, choose Tools - Options - StarOffice - Paths.

» Samples - The provided samples show you what you can do with StarOffice.
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Saving Documents

To save your current document, use the Save command in the File menu,
the Save Document icon on the function bar, or just press Ctrl+S.

When you save a document for the first time a dialog will appear in which you
choose where you want to store the file.

Save as
F:4officeG0_01 | ﬁi | Y| |
Title % [ Type [ size | pate modified
[Z1 help Folder 201242001, 111905
[:| program Folder 2041272000, 11:2258
[C] share Folder 201272000, 11737
2] user Falder 07./01/72002, 095712

File: riame: I j — I
File type: |starDtfice 60 Text Document | — |

Help |
[ save with pazsword 7 Automatic file name extension

Assign your text document a name when you save it the first time. You can, for the
most part, choose any name you'd like (according to the restrictions of your oper-
ating system). When you want to open the document later, you can find it under
that name.

Save your documents regularly as you work on them. The simplest way is to save
the current document by pressing (Ctrl) (S). This replaces the document on the
data medium with the current document.
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Changing Your Work Directory

When you start a dialog in StarOffice to open a document, initially you see your
work directory there. You can change the directory which StarOffice displays here,
as follows:

1. Choose Tools - Options - StarOffice - Paths.
2. Double-click the entry My Documents.

3. In the Select Path dialog, choose the work directory you want and click Select.
Close the following dialog with OK.

In a similar way you can change the directory displayed by StarOffice when you
want to insert a graphic: Change the path for the entry Graphics.

Saving Documents Automatically

To save a backup every time you save a document
1. Choose Tools - Options - Load /Save - General.
2. Mark Always create backup copy.

If you save the current document with File - Save or (Ctrl)(S), under the path and
file name from which you opened it, the old version will be overwritten by the
new version. If the Always create backup copy check box is marked, the old
version is first copied to the backup directory.

» The backup directory is staroffice6.0\user\backup. You can change it in the
Tools - Options - StarOffice - Paths dialog in the "backup" entry.

» The copy has the same name as the document, but the extension is .BAK. If the
backup folder already contains such a file, it will be overwritten without
warning!
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To save automatically every n minutes
1. Choose Tools - Options - Load/Save - General.
2. Mark AutoSave every and select the time interval in the spin button.

3. Mark Prompt to save if you want to be asked prior to automatic saving
whether or not you want to save the document.

This command saves the current document as if you pressed Ctrl+S, for example.
If the document was saved previously, the old version will be overwritten by the
current version.

f If you mark both check boxes Always create backup copy and AutoSave every,
* the file will be overwritten every n minutes. At the same time, the backup copy
will be replaced by the last version.

XML File Formats

StarOffice uses an XML file format as the default for saving and opening its docu-
ments.

XML file format names

If in the dialogs for saving and opening StarOffice documents you do not select
any other file type, StarOffice uses the following XML formats:

Application File extension
StarOffice Writer *. SXW
StarOffice Writer templates *.stw
StarOffice Calc *.sXcC
StarOffice Calc templates *.stc
StarOffice Impress *.sxi
StarOffice Impress templates * sti
StarOffice Draw *.sxd
StarOffice Draw templates *.std
StarOffice Math *.sxm
Master documents *.5Xg
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These file name extensions on the one hand allow better differentiation if you are
searching though a lot of files of different file types in a directory. And on the
other, from the name, it is clear that compressed XML files are involved that must
first be unpacked before being read, for example, by a text editor.

If you want to work permanently with another file format, you can define this as
the default. If you choose Tools - Options - Load/Save - General there are alter-
native file formats that can be selected for each StarOffice document type.

XML file structure

The StarOffice XML file formats are compressed according to the ZIP method. Use
an unpacking program of your choice to unpack the content of an XML file with
your subdirectories. You see a structure similar to the following illustration.

| Type | Path 3
*ML Document
File
#ML Document
#ML Document
#ML Document
ML Document Basich
ML Document BasichStandard'
ML Diacument meta-inf

rnatifest. il

= The text content of the document is located in content.xml. You can view this
file with, for example, a pure text editor.

By default content.xml without indents is stored at the start of the line in order
to minimize the time for saving and opening. By choosing Tools - Options -
Load/Save - General you can change this procedure so that the lines are saved
with a structured indent.

= meta.xml contains, inter alia, the meta information on the document, which you
can enter underFile - Properties.

If you save a document with security, only meta.xml is not secured.

» settings.xml contains further information on settings for this document, for
example on the printer, on the recording of changes, the associated data sources
and so on.

= Instyles.xml you find the styles defined for the document that can, for
example, be seen in the stylist.
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» The meta-inf/manifest.xml file describes the structure of the XML file.

Additional files can be contained in the packed file format. Illustrations are, for
example, contained in a Pictures subdirectory, Basic code in a Basic subdirectory
and linked Basic libraries are found in further subdirectories of Basic.

Definition of the XML formats
The DTD (Document Type Description) files can be found in staroffice6.0\share\dtd.

Note that the formats are subject to certain licenses. You can find notes on the
licenses at the start of the DTD files. More detailed information can be found on
the OpenOffice.org website.

Sending Documents as E-Mail
Working in StarOffice, you can send the current document as an e-mail attachment.
1. Choose File - Send - Document as E-mail.

StarOffice opens your default e-mail program. If you want to send it with
another program, select it with Tools - Options - StarOffice - External
Programs.

2. In your e-mail program, enter a recipient, subject and any text you want to add,
and send the e-mail.
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Printing a Document

Once you have finished creating your document, you may want to print it out on
paper. Although more and more documents are being produced that are not
intended to be published on paper, such as the pages of StarOffice Help, graphics
for Internet pages, presentations and so on, it may be helpful to print out a hard
copy, rather than having to check everything on screen.

You print the current document either directly to a printer, or "to file". When you
print to a file, all the information that would otherwise be sent to the printer is
initially written to a file. On another computer, the file can then be copied directly
to the printer connected to it.

StarOffice Writer always formats documents so that they are printed as well as
possible with the selected printer. Therefore you must always define a default
printer, even if you do not have a printer.

Click the Print File Directly icon on the function bar to print the current
document without the intervention of a dialog.

You control printing mainly with the Print dialog, which you open by choosing
File - Print, or with the shortcut keys Ctrl+P.

Print

Printer
Properties... |

Marne

Status Default printer; Ready

Type Herox DocuPrint M23/M32/M40 P52

Lacation Ipr2

Comment

™ Print to file |
Print range Copies

2 Mumber of copies |1 E i
" Pages |1
1 Selection I= Collate

Options... | Ok I Cancel | Help |
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In this dialog, you can select a specific printer (if you have installed more than one
printer). Under Print range, you can determine how many pages you want to have
printed (or only certain pages), and how many copies you want.

# There are many different printers with widely varying properties. The printing
functions differ according to the operating system, printer driver and printer
model used.

The selected printer defines the width and height of the characters, and hence
also the line and page breaks. StarOffice Writer and Calc always format the pages
in the way they will appear when printed.

Besides the general printing options already mentioned, you can define special
printer options for the different document types in StarOffice using additional
dialogs that allow you to control the way the contents or the pages of the docu-
ment are printed. Define these printer options for the current print job by clicking
the Options button in the Print dialog. You can create a general definition by
choosing Tools - Options - (name of document type) - Print.

Displaying Print Previews

Before printing out a document, you can obtain a preview of how the printed
document will look, so you can adjust margin widths, optimize page breaks etc.

1. Switch to the document you want to preview.

2. Choose File - Page Preview.

3. o BS Use the icons on the object bar to zoom in or out.
4. Use the arrow keys or object bar icons to scroll through the
Ed CH [4 b pages of the document and check how they will appear in
print.
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Reduced Printing of Documents

If you would like a reduced printout of your text document so as to save paper,
choose File - Page Preview. Here you can decide whether to have two, four or any
number of pages beside and on top of each other.

To print two pages beside one another on one sheet of paper

1. Choose File - Page Preview.

2.y You will see the Page Preview with two pages alongside each other. If
you see more or fewer pages, click the icon Page Preview: Two Pages on
the object bar.

3. oy Click on the Print page view icon. Click OK to confirm.

4. ) Clicking the Print options page view icon starts a dialog where you can
enter settings for reduced printing.

Printing in Black and White

If you have a color printer but only wish to print in black and white, you have the
following options:

Printing text and graphics in black and white
1. Choose File - Print. This opens the Print dialog.
2. Click on Properties. This opens the properties dialog for your printer.

3. Select the option to print in black and white. For further information, refer to
the help for your printer or read your printer manual.

4. Confirm the Properties dialog and click OK in the Print dialog.

The current document will be printed in black and white.
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Printing in black and white in StarOffice Impress and
StarOffice Draw

1. Choose Tools - Options - Presentation or Tools - Options - Drawing, as
appropriate.

2. Then choose Print.
3. Under Quality select either Grayscale or Black & white and click OK.

From now on, all presentations or drawings will be printed without color. If
you only want to get rid of color for the current printing process, select the
option in File - Print - Options.

Selecting the Default quality option allows documents to be printed in color
again later on.

Grayscale converts everything to a maximum of 256 gradations from black to
white.

Black & White converts everything into the two values black and white.

Printing only text in black and white

In StarOffice Writer you can choose to print color-formatted text in black and
white. You can specify this either for all text documents to be printed subse-
quently, or only for a printing process of the current text document.

Printing all text documents with black and white text

1. Choose Tools - Options - Text Document or Tools - Options - HTML Document.
2. Then choose Print.

3. Under Contents mark Print black and click OK.

All text documents or HTML documents will from now on be printed with
black text.
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Printing the current text document with black and white text
1. Choose File - Print. This opens the Print dialog.

2. Click the Options button. This opens the Printer Options dialog.

3. Under Contents mark Print black and click OK.

The text document or HTML document now being printed will be printed in
black text.

Printing Brochures

StarOffice text documents consisting of more than one page can be printed auto-
matically as a brochure. Two pages of a text document will be reduced in size and
printed next to each other on a page in landscape (horizontal) orientation. Both
sides of the page will be printed (most printers require that you take out the paper
after the first half of the printing process and feed it in again with the blank side of
the page facing upward). StarOffice will automatically print the pages so that you
can read them as a brochure.

StarOffice automatically arranges the pages in such a way that you can read the
text continuously if you lay the pages together, fold them in the center and staple
them.

= To use this function with the current document, choose File - Print. In the
dialog that opens, click the Options button. Mark the Brochure check box.
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Spellcheck

StarOffice has an automatic spellcheck which can be active as you type, or which
you can open separately.

Automatic Spellcheck

You can turn the automatic spellcheck that works as you type on and off by
clicking the AutoSpellcheck on/off icon on the main toolbar. With automatic
checking enabled, words recognized as incorrect are highlighted with a wavy red
underline.

A word is recognized as incorrect if all the following conditions are met: a spell-
check module is installed for the language of the word, this is enabled, the word is
not found there and the word is not in any active user dictionary.

You can create any number of user dictionaries. You create a user dictionary by
choosing Tools - Options - Language Settings - Writing Aids .

When you proofread your text, the wavy underlines will draw your attention to
possible spelling mistakes. Of course, the Spellcheck function won't be able to
catch spelling mistakes that form other recognizable words (such as "fun" instead
of "run"). As long as the automatic spellcheck is activated, the red markings can be
seen on the screen but will not be printed.
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The easiest way to correct a red-underlined word is to right-click it. This opens a
context menu that offers you several alternative words to choose from. If you click
one of the alternatives, the red-underlined word will be replaced with the alterna-
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tive. If you want to include the red-underlined word in your user dictionary,
because it is correctly typed, you can do this via the context menu as well.

When you replace a red-underlined word with a suggestion from the spellcheck
via the context menu, you will find your work is made much easier when it comes
to dealing with frequent typing errors. When you click the suggestion, StarOffice
not only replaces the red-underlined word with the suggestion you clicked, it also
remembers this replacement for the remainder of this StarOffice session. As soon
as you make the same typing error, StarOffice automatically replaces the mistyped
word with the word you replaced it with previously.

Checking Multilingual Texts

StarOffice Writer can manage spellchecking (plus thesaurus and hyphenation) in
several languages. In the StarOffice setup program, during "Custom Installation"
and later with the "Modify" option, you can choose which language modules you
want to install.

You select the language of your entire text document with Tools - Options -
Language Settings - Languages. If applicable, mark For the current document
only. For all paragraphs formatted with the same Paragraph Style, you can apply a
language via the Paragraph Style. You can select a language for individual words
via Character Styles, or directly with Format - Character.

In Tools - Options - Language Settings - Writing Aids you can mark the option
Check in All Languages. Now, the spellcheck will take all installed languages into
account. Words that are correctly typed in any of the installed languages are
regarded as correctly typed, irrespective of their language attribute.

In multilingual texts, the automatic checking that you enabled by clicking the icon
on the main toolbar offers you another facility as well. In the context menu of a
red-underlined word that is recognized as incorrect, you can specify that the word
or the whole paragraph is present in one of the other installed languages. The
language of the underlined characters or all characters of the paragraph is auto-
matically assigned as a direct character format.
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Starting the Spellcheck

To check your entire text for spelling mistakes in the "classic" way (i.e. letting the
Spellcheck go through the whole document on its own), go to the Tools menu and
choose Spelling - Check. The Spellcheck dialog will only appear if there are
words in your text unknown to the Spellcheck. The various options to be seen in
the Spellcheck dialog are described in detail in the StarOffice Help.

Spellcheck [Englizh [USA]) B

Original sratement lgnore |
Wiord - ratement o :‘}c—l Ignore Al |
.

Suggestions
Always Replace |

AtoEorrect |

Thesaurus.. |
Language I"'icf English (U54) j Options... |
Dictionary Isoffice [Adl] j Add | - Backwwards

Unkrdwm wiard. Help | Clase |

In the Spellcheck dialog, if you include an unrecognized word in a user dictionary,
you can, if you want, at the same time define the permitted hyphens for the auto-
matic hyphenation. Enter the hyphens in the word as an equals sign (=). (Note:
placing the equals sign at the end of the word means that this word will never be
automatically hyphenated.)

Excluding Text From the Spellcheck

If you do not want certain areas, words or tables to be checked by the spellcheck
function because they are, for example, in a foreign language for which you have
no module, then specify "Unknown" as the language. You can either use direct
formatting to do this (select your text and then choose Format - Character - Font)
or modify the corresponding Style for the text (open the context menu and choose
Edit Paragraph Style...).
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Using Automatic Functions

StarOffice has all kinds of intelligent assistants to help you in your work, all of
which have names beginning with "auto".

Here we introduce you to just a few of these auto-functions. For detailed explana-
tions, refer to the StarOffice Help.

Using AutoCorrect and AutoFormat

If you want it to, StarOffice will format your documents as you type or thereafter,
and correct any typing errors you may make. Once you have gotten used to using
the AutoFormat and AutoCorrect functions while you type, you will be able to
draft your documents much more efficiently. Here are a couple of examples.

AutoCorrect functions are helpful if you often make the same typing errors. If, for
example, you tend to capitalize not only the first letter of some words but also the
second, simply select the AutoCorrect function that corrects mistakes of this sort
while you type.

AutoFormat formats your texts. One of the AutoFormat functions automatically
detects a paragraph beginning with a minus sign followed by a tab stop or space,
and reformats it as a bullet point. The automatic bulleting is then applied to subse-
quent paragraphs as well. Automatic bulleting ends when you do not enter any
text in a new paragraph, but only press Return.

To switch AutoFormat for text documents on and off, choose Format -
AutoFormat. In the submenu, mark the While Typing command, if you want
AutoFormat to work as you type. Alternatively, choose the menu command Apply
later on, to automatically format the whole document or the current selection after-
wards.

By using the Apply and Edit Changes command you will see all document
changes made via AutoFormat. You then have the choice of accepting or rejecting
all changes or reviewing each change separately.

You set the options in Tools - AutoCorrect/AutoFormat. AutoCorrect offers many
functions that you can turn on and off individually, in some cases separately for
typing and post-processing. The Replace and Exceptions lists are language-
dependent. StarOffice first searches in the list applicable to the language of the
text, then in a list for the higher ranking language family, and finally in all
installed languages (e.g. first in "English (US)", then in "English", then in "All
Languages").
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Note the functions in the illustrated dialog. A detailed explanation of each function
is given in StarOffice Help. In addition to the functions shown here, you can also
select Custom Quotes. This means that all quotation marks that you enter as a
simple computer character with (Shift)(2) are automatically turned into correct
typographer's quotes. You yourself can choose the characters to be used for this
purpose.

Turning off URL Recognition by AutoCorrect

When you enter text, StarOffice automatically recognizes a word that may be a
URL and replaces the word with a hyperlink. StarOffice formats the hyperlink
with direct font attributes (color and underline) the properties of which are
obtained from certain Character Styles.

If you do not want StarOffice to automatically recognize URLs as you are typing,
there are several ways of turning off this feature.
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Undo URL recognition

When you are typing and notice that a text has just been automatically
converted into a hyperlink, press Ctrl+Z to undo this formatting.

If you do not notice this conversion until later, select the hyperlink and choose
Format - Default.

Turn off URL recognition

1.

Load a document of the type for which you want to modify the URL recogni-
tion.

If you want to modify the URL recognition for text documents, open a text
document.

Choose Tools - AutoCorrect. (In StarOffice Writer, choose Tools - AutoCor-
rect/AutoFormat.)

In the AutoCorrect dialog, select the Options tab.

If you unmark URL Recognition, words will no longer be automatically
replaced with hyperlinks.

In StarOffice Writer there are two check boxes in front of URL Recognition.
The field in the first column is for later post-editing and the field in the second
column is for AutoCorrect as you type.

Other AutoCorrect functions

The AutoCorrect dialog includes a Replace tab, containing many instances of auto-
matically replaced text. This is where you can enter your most frequent typos and
have AutoCorrect replace them with the right word. You can also use this feature
to enter characters that normally take time to enter from the keyboard. For
example, when you type (C), this is immediately turned into the copyright symbol,
provided the Use replacement table check box on the Options tab page is marked.
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The fonts supplied with StarOffice include the euro symbol. If you work with
other fonts, you can easily insert the euro symbol from another font using Auto-
Correct. When working in a text document, choose Insert - Special Character.
Look for the euro symbol and click OK.

-

Select the euro symbol. Choose Tools - AutoCorrect/AutoFormat. The selected
euro symbol has already been inserted in the Replace with text box (although it
may not appear if the system font used in the dialog does not contain this
symbol).

Enter in the Abbreviation text box eu, for example. The Text only box should not
be marked. Click New. Now close the dialog. As soon as you enter the eu
followed by a space or at the end of a sentence, a euro symbol will be inserted.

On the Exceptions tab, you can enter exceptions for two types of automatic correc-
tion which are described below.

If you select the option to automatically start each sentence with a capital (upper-
case) letter, then a lowercase "d" following "e.g." would be capitalized, for
example. You can enter "e.g." as an exception to prevent this type of correction.

If you select the option to automatically convert the second of two capital letters at
the beginning of a word to a lowercase letter, you can enter exceptions that are
correctly written with two capital letters, such as PC and CD.

These exceptions can also be automatically incorporated into the tab page. To do
this, use Add Automatically fields on the Exceptions tab page. If you have
selected these and you then use an idiom in your text that is automatically
corrected even though it isn't wrong, you need to immediately press Ctrl+Z. Doing
this not only undoes the automatic "correction”, but also sees to it that this
particular "correction" will not be made automatically again.

AutoCorrect can also be used to replace one word with another - for example,
"ASAP" with the text "as soon as possible" - although the StarOffice AutoText
function is much better suited for such purposes.

50 StarOffice 6.0 User's Guide * March 2002



Creating a Letter Template With the AutoPilot

If you are writing a personal letter, the AutoPilot and standard AutoTexts are not
essential, but in formal business correspondence these aids can save you a lot of
time and make your work much easier.

If you need to produce a standard letter, have a look at the supplied templates.
Simply press the shortcut keys (Shift)(Ctrl)(N) or choose File - New - Templates
and Documents.

Start the AutoPilot with the File - AutoPilot - Letter menu command.

AutoPilot Letter x|

Select the letter template you want to create.

€ Personal letter

‘Which layout do you prefer?
& Modern
" Classic

" Decorative

Help | Cancel | <o BT | Mext »= | Lreate |

In this short introduction, accept all the defaults provided by the AutoPilot
without changing them, and then print the result. You could click on the Create
button right away, but to familiarize yourself with this function you should click
Next on each dialog page, so that you have seen every page at least once.

Have a look through the AutoPilot pages for creating a letter template. You don't
have to enter data or modify options on each page, but you can if you want to.
Each page allows you to make modifications according to your preferences. Of
course, sender and recipient addresses can also be entered manually, because,
although predefined elements will appear, you have the final say as to which
elements you want to include in your letter.

The sender information is automatically taken from the details that you entered at
the time of installation. You can change these details at any time by choosing Tools
- Options - StarOffice - User Data and entering new details.
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You do not need to go through all the steps of the AutoPilot each time you want to
write a letter. Although the AutoPilot does produce a document that you can
immediately fill in, print, and send, the main purpose of the AutoPilot is to help
you create a customized document template.

The AutoPilot creates a template which can be edited and then used as a custom-
ized template for all your letters. This ensures that your correspondence will have
a consistent format. This also applies to other types of documents which can also
be created with the AutoPilot (e.g. faxes).

Thanks to the AutoPilot, you don't have to start from scratch but can use pre-
existing texts when creating your own templates, whether for business letters,
faxes, memos, or other documents.

Find & Replace

It is very useful when working with a computer to be able to locate certain pieces
of text quickly. The Find function in StarOffice Writer, Calc, Impress and Draw can
also find variations of the search terms, or limit the search to certain places in the
document, such as the beginning of a word or the end of a paragraph.

The text strings found in the text can be replaced by other strings with or without
confirmation, although sometimes manual editing is still necessary (e.g. a devia-
tion of gender in other languages).

Finding a Word in Text

Imagine you have read (or written) the word "Holland" somewhere in a long text.
Now you want to return to that point in the text, but can't remember where it was.
If this happens, activate the Search function with Ctrl + F. Type the word you want
to find and press Enter.
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StarOffice will start searching, moving from the cursor position downwards. When
the end of the document is reached, a dialog will appear asking if you want to
continue the search at the beginning of the document. Press the Enter key to
confirm. If the text string is found, it will be highlighted.

The Find & Replace dialog will remain open. You don't have to close the dialog
and you can move it to any place on the screen. However, if you do choose to close
it, it will retain the previously entered strings so you won't have to enter them
again for the next search, but can select them from the list box.

A very useful feature is the multiselection facility available in StarOffice, used in
conjunction with the Find All button. Suppose, for example, you want to set every
occurrence of the word "Bold" in your text in bold type, type the word in the
Search for box, then click Find All. All occurrences are now selected, and you can,
for example, click the Bold icon in the text object bar, to format all occurrences in
bold.

As you can see in the dialog, there are several ways of expanding or restricting
your search in both the Options group box and with the buttons. Examples for
each option are described below.
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Searching for Whole Words Only

Select the Whole words only option if you only want to find whole words that
match the searched for word. For instance, if the word "in" is entered as the search
term in the Search for field, all instances of "in" or "In" as stand-alone words in the
text will be found. Words like "bin" or "chin" will not be found if this check box is
selected. If you are searching for regular expressions or Styles, do not select this
option.

Match Case

When this check box is selected, the search is case-sensitive to uppercase and
lowercase letters. So if you search for "in," it will be found, but not the word "In."
You can combine a Match case search with the Whole words only option.

Searching for Text With Wildcards

1. Call the Find & Replace dialog, using Ctrl+F.
2. Mark the Regular expressions check box.
3. Enter the search term with the desired wildcards and click Find.

Regular expressions are shown in a form that should be familiar to Unix command
line users.

» The wildcard for any number of a given character is the character itself
followed by an asterisk. For example:
If you enter "Hawai*" as the search word, this means than any number of "i's"
may occur after "Hawa", but do not have to. The words "Hawa", "Hawai" and
"Hawaii" will be found.

= The wildcard for a single character is the period. This is equivalent to the wild-
card ? in file names.

= The wildcard for several characters in succession is .* (period and asterisk). This
is equivalent to the wildcard * in file names.

= A paragraph end can be found with the dollar sign ($), and the first character at
the beginning of a paragraph with the string ~. (caret and period).

= You can only search for regular expressions within paragraphs.

There are many other wildcards that you can use listed in the StarOffice Help.
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Searching Backward

If you want to find in a particular part of a long text a specific word that is used
often, you would probably enter the word under Search for and then skip each
irrelevant location by repeatedly clicking the Find button. However, you might
click Find once too often by mistake. In this case, select Backward and click again
on Find to return to the previous location found.

Current Selection Only

Select the Current selection only option if you do not want to search the entire
document. The search will be restricted to the range selected in the document. If
you select a text before activating the Find command, the search will automatically
take place only within the selected range.

Searching for Styles

This option enables you to quickly reformat all or part of a text. For example, text
formatted with the Style "Heading 2" can be replaced with the Style "Heading 3."
Select the Paragraph Style in the list box under Search for. Then select the new
Paragraph Style in the Replace with field.

Start the replacement process with the Replace button. All matching strings found
in the text will be displayed one after the other. You can decide each time whether
or not to replace the string found in the text, to replace this and all other strings
found in the text, or to cancel the process.

Searching for Attributes

Click Attributes to open a dialog in which you select specific text attributes to
search for within a document. StarOffice will then find all attributes that differ
from the format of the Paragraph Style.

Options
Ok I
[ slignment -
[] Blinking Earrel |
[ Character background

[ Effects

[ Fant Help |
[ Font caloe

[ Fant pasture

[ Fant size

[ Font weight

] Hypheration

[ Indent

[ Individual wards

[ keep with next paragraph ;I
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In this dialog, if you mark the Font Weight check box, for example, you can find
all words that have a heavier font than normal. These are words to which you have
applied the Bold attribute through direct or indirect formatting, but also words
that you have highlighted with a font previously defined as a bold font, such as
ones containing the words "Bold" or "Black” in their name.

By default, only direct attributes are looked for. However, after you have looked
for the attributes, you can mark the Including Styles check box in the Find &
Replace dialog (this appears in the place where Search for Styles previously
stood). Then, besides the direct attributes, it also finds the indirect attributes, i.e.
those set with styles.

Searching for Special Formats

Click the Format button to open a dialog in which to select the specific formats you
want to search for. For example, if you have manually centered a few lines in your
text, you can search for them using the options in the Text Format (Search) dialog.

If you want to replace the found attribute with another, first position the cursor in
the Replace with field. Next, click the Format button and then choose the replace-
ment attribute. The chosen attributes will be listed under the Search for and
Replace with fields. If you do not indicate the replacement for the attribute found
in the text, the default settings are automatically applied.

The Similarity Search
This function looks not only for the search term, but also for similarly typed

words. You yourself can specify the degree of similarity when you click the button
opposite the "Similarity search" check box.
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CHAPTER 3

Creating Text Documents With
StarOffice Writer

In this section, you will learn about the StarOffice word processing module, called
StarOffice Writer. First, basic instructions are given, then more sophisticated func-
tions are described. At the end of the chapter, we explain some of the templates
and sample documents supplied with the module.

Further important information on working with texts in StarOffice Writer can also
be found in the other chapters of this guide.

= The general use of menus, windows, floating toolbars and so on is described in
the chapter "The User Interface" starting on page 25.

» Information about customizing the user interface of StarOffice, working with
data sources, e.g. for form letters, and about the revision marking function is
contained in a separate chapter "Advanced Tips for Working With StarOffice",
starting on page 373.

The StarOffice Writer Functions

This section contains a brief overview of the functionality and capabilities of
StarOffice Writer.

Writing

StarOffice Writer helps you to create all sorts of written documents. You can
produce personal letters, form letters, brochures, faxes, and even professional
manuals. Documents that you use often can be saved as templates, for example,
an invoice form. The spellcheck and thesaurus functions are at your disposal. If
you want, you can have the AutoCorrect and hyphenation functions active as you

type.
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There is no restriction to the length of a text document in StarOffice. You can use
the Navigator to move around easily and quickly within the document.

StarOffice Writer comes with a variety of templates for almost every purpose. You
can also create your own using the AutoPilot.

Designing and Structuring

StarOffice offers a wide variety of options to design documents. Use the Stylist to
create, assign and modify styles for paragraphs, individual characters, frames and
pages. In addition, the Navigator can help you create structured texts and also
allows you to modify the structure, for instance, by shifting paragraphs from one
position to another.

Additionally, you can create various indexes and tables in text documents. You
can define the structure and appearance of the indexes and tables according to
your individual needs. Live hyperlinks and bookmarks let you jump directly to the
corresponding items in the text.

Desktop Publishing with StarOffice Writer

StarOffice Writer contains numerous functions to assist you in creating perfectly
styled documents. Text can be formatted multi-columnar, and have text frames,
graphics, tables, etc. integrated into it. The text frames can be linked all over the
place, even beyond page limits to create a newspaper format. Functions such as
making lines register-true, flow of contours through and around graphics, and
defining of characters, paragraphs and tables in any color complement your tools
to lend your documents a professional look.

Calculations

Text documents in StarOffice have an integrated calculation function that helps
you execute sophisticated calculations or logical links. You can easily create a table
in a text document in order to perform calculations.

Creating Drawings

A handy drawing tool lets you create drawings, graphics, legends, etc. directly in
text documents.

58 StarOffice 6.0 User's Guide * March 2002



Inserting Graphics

You can insert pictures with different formats into a text document, including
graphics with a JPG or GIF format. The most common formats can be edited
directly in a text document with the image editor. In addition, the Gallery provides
a collection of clipart graphics organized by theme.

Flexible Application Interface

The program interface is designed so that each user can configure it according to
individual preferences. The various windows (Stylist, Navigator, etc.) can be posi-
tioned as floating windows anywhere on the screen and some can be docked to an
edge. Visible icons and menus can be customized as well.

Drag&Drop

The drag-and-drop feature enables you to work even more quickly and efficiently
with text documents in StarOffice. For instance, you can drag graphics directly
from the Gallery into an active document.

Extensive Help Functions

The program provides an extensive Help function which serves as a reference
guide to the program elements in StarOffice as well as includes a variety of
instructions for simple and complex tasks.
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The StarOffice Writer Window
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Windows in StarOffice Writer

Insert floating toolbar
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Entering and Formatting Text

You do not have to work in any particular sequence to enter or format text. You
can enter text and, let us say, underline it or italicize it while you type or after-
wards, and you can decide either there and then or later on to split a section of text
into two columns. You never have to delete text and retype simply because you
want to alter the formatting.

Basically, to edit text, you first select it and then choose the relevant command,
such as the one to format the text in italics. There are several ways of selecting text,
for example, using the arrow keys whilst holding down the Shift key, or with the
mouse whilst keeping the mouse button depressed. Often there are different ways
of choosing a command, for example, with a menu command, with a toolbar icon
or with shortcut keys.

Entering New Text
To enter new text:
1. Open an existing text document or create a new one.

2. Enter text using the keyboard.
If you want to enter special characters which are not available on your
keyboard, choose Insert - Special Character and select the desired character
from the table.

3. Press Enter to begin a new paragraph.

Line breaks

You do not need to worry about line breaks as the software inserts these automati-
cally. Only press Enter where you want to start a new paragraph.

Automatic correction

StarOffice Writer can make various corrections automatically while you type. For
example, it can automatically start every sentence with a capital letter.

Word completion

The automatic word completion helps you enter text. If you often use the same,
long word, StarOffice Writer will suggest the recognized word. Press Enter (or you
can define another key) to accept the suggestion.
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Inserting Text

1. Open an existing document.

2. Using the mouse or the arrow keys, place the cursor at the point where text is to
be added, and enter new text.

By default, you are in Insert mode; text after the insertion point is moved on as
you enter the new text. If you would like the existing text at this point to be
overwritten with the new text, select Overwrite mode.

Switching Between Insert Mode and Overwrite Mode
With the keyboard:

Press Ins to toggle between overwrite mode and insert mode. The current mode is
displayed on the status bar.

With the mouse:

On the status bar, click on the button indicating the current mode to switch to the
other mode:

= INSRT

Insert mode is enabled. The text cursor is a blinking vertical line. Click in the
field to enable overwrite mode.

« OVER

Overwrite mode is enabled. The text cursor is a blinking block. Click in the field
to enable insert mode.
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Entering Text Anywhere on a Page

The direct cursor enables you to enter text at any position within the type area in
your text document.

1.

Click the Direct Cursor on/off icon on the main toolbar.Clicking the icon
turns the direct cursor on and off. When the icon appears pressed, the
direct cursor is enabled.

Click on a free space in the text document. The shape of the mouse pointer
shows you how the text you enter will be aligned.

P Align Left 4|p Centered 4| Align Right

Enter your text. StarOffice automatically inserts the requisite number of blank
lines, tabs and spaces.

Selecting and Deleting Text

Deleting a character

If the cursor is after the character to be deleted, press Backspace (above the
Enter key). This key deletes one character to the left of the cursor.

If the cursor is before the character to be deleted, press the Delete key (above
the arrow keys). This key deletes one character to the right of the cursor.

Deleting text

Selecting text to delete with the mouse

1.
2.

Left-click on the first character to be deleted.

Keeping the mouse button depressed, drag the pointer to the last character to
be deleted.

Release the mouse button.

Press the Delete key to delete the selected text.
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Selecting text to delete with the keyboard
1. Use the arrow keys to go to the first character to be deleted.
2. Hold down the Shift key.

3. Using the arrow keys, move the cursor to just after the last character to be
deleted.

4. Release the Shift key. The text appears selected.

5. Press the Delete key to delete the selected text.

r You can also delete selected text by pressing Ctrl+X instead of Delete. This cuts
out the text and places it on the clipboard. You can then paste it back in, wher-
ever and as often as you like, by pressing Ctrl+V.

ﬁu‘}

Deleting non-adjacent pieces of text.
1. Press Ctrl and keep it pressed.
2. Left-click on the first character of the first piece of text to be deleted.

3. Keeping the mouse button depressed, drag the pointer to the last character of
this piece of text.

4. Release the mouse button and the Ctrl key.
5. Repeat steps 1 to 4 for each piece of text to be deleted.

6. Press the Delete key to delete the selected text.
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Navigating and Selecting With the Keyboard

To navigate and select with the keyboard, in addition to the arrow keys you can
also use Home, End, PgUp and PgDn. Certain keys have different functions
depending on whether they are used on their own or in combination with the Ctrl
key. The following table provides an overview of the keys used for navigation.

Key Function +Ctrl key
Right/left Go one character to the left or Go one word to the left or right
arrow keys right
Up/down Go one line up or down Move the current paragraph up
arrow keys or down
Home Go to the beginning of the Go to the beginning of the docu-
current line ment
Home Go to the beginning of the 1. Go to the beginning of the
Inatable current cell current cell
2. Go to the beginning of the table
3. Go to the beginning of the
document
End Go to the end of the current row  Go to the end of the document
End Go to the end of the current cell 1. Go to the end of the current cell
In a table
2. Go to the end of the table
3. Go to the end of the document
PgUp Scroll one page up the screen Switch to the header and back
PgDn Scroll one page down the screen  Switch to the footer and back

Chapter 3  Creating Text Documents With StarOffice Writer 65




Inserting Special Characters

This is how to insert special characters (such as check marks, boxes, telephone
symbols etc.) in your text.

= To view a selection of all characters, choose Insert - Special Characters.

= In the large selection field click the desired character or several characters in
succession. The characters are displayed at the bottom of the dialog. When you
close the dialog with OK, all displayed characters in the selected font are
inserted in the current document.

= Inany text input field (e.g. in the URL field of the function bar or in the input
fields in the Find&Replace dialog) you can press Shift+Ctrl+S to call the Special
Characters dialog.

Inserting Protected Spaces, Hyphens and
Conditional Separators

Non-breaking spaces

To prevent two words from being separated at the end of a line, press the (Ctrl)
key when you type a space between the words. This is important, for example,
between a title and the person's name.

Non-breaking dash

An example of a non-breaking dash would be in a company name such as A-Z.
Obviously you would not want A- to appear at the end of a line and Z at the begin-
ning of the next line. To solve this problem, press Shift+Ctrl+ minus sign. In other
words, hold down the Shift and Ctrl keys and press the minus key.

Hyphen, dash

In order to enter longer dashes, you can find under Tools -
AutoCorrect/AutoFormat - Options the Replace dashes option. This option
replaces one or two minus signs under certain circumstances with a long dash(see
StarOffice Help).

66 StarOffice 6.0 User's Guide * March 2002



For additional replacements see the replacements table underTools - AutoCor-
rect/AutoFormat - Replace. Here you can, among other things, have a shortcut
that you have defined automatically replaced when input by an optional dash,
even in another font.

Definite separator

To support automatic hyphenation by entering a separator inside a word yourself,
use the Ctrl+ minus sign. The word is separated at the end of the line at this posi-
tion even if automatic hyphenation for this paragraph is switched off.

Emphasizing Text
There are many ways of emphasizing text in a special way. Here are some of them:

» Use the "normal" Formatting (e. g. with the icons in the text Object bar). Some
possibilities are: create the text in bold or in another font style, change the text
color and background, or center the text.

» If you want to visually emphasize a whole paragraph, open its context menu
and select Paragraph, then click on, for example, the Borders tab. Here you can
select a border to frame the paragraph, and also a shadow if desired. If neces-
sary you can change the interval between the border and the paragraph text
under Spacing to contents.

» Enter the text in a Text Frame. You have the following possibilities: The text can
receive a border, it can be placed outside of the text margin on the side of the
page, and you can link text frames if a text should flow from one frame to
another.

» Choose Format - Paragraph - Background to apply a background color to the
paragraph.

Use the Text drawing function: With the Text icon on the Draw function
floating toolbar (from the main toolbar), drag open a frame and enter your
text. This text can be positioned as you like, which includes rotating at
various angles, or curving and slanting your text with the help of Format -
FontWork.
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Changing the Color of Text

Click the Font Color icon in Writer and other modules, and keep the mouse button
pressed to obtain a floating toolbar from which you can choose from a range of
colors.

A Font Color (Writer)

A Font Color (other modules)

The following only applies to StarOffice Writer: If you confirm the symbol with a
short-click while no text is selected, then the mouse pointer changes its appearance
and is displayed as a watering can. Use this watering can symbol with the mouse
key pressed to drag across a text area. This text area takes the selected color. The
function remains active for as long as the symbol is "pressed”, or until you just
click without dragging, or until you press the (Esc) key.

The following applies to all modules (Writer, Calc, Draw, Impress): Select the text
that is to take another color, then click the color you want on the floating toolbar.

Rotating Text

If you want to rotate text, type it into a text frame:

o Open the Draw Functions floating toolbar on the main toolbar.

T On the floating toolbar, click on the Text icon. The mouse pointer now indi-
cates that you can open up a text frame.
Open up a text frame, release the mouse button and type in your text.

C» Click on the edge of the text frame. You will now see the Draw Object Bar,
which contains the Object Rotation Mode icon. Click on it.

Now, if you click on one of the handles in the corners of the text frame and
drag the mouse, the whole text frame turns with the text.

In the context menu of the Text Frame, you can start the Position and Size dialog

by selecting the Rotation tab. This allows you to define the precise angle of rota-
tion numerically.
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Defining Borders

You can define the borders of pages, paragraphs, tables and other objects in two
places:

» Choose Format - (object name) - Borders

= Borders floating toolbar on the object bar, if the object is selected (does not
apply to all objects).

Choose Format from the menu bar, Borders tab page

To set a border, you can also use the Borders icon on the object bar. This opens a
floating toolbar from which you can select predefined borders.

Icon on the Object Bar:
[0 Border Floating Toolbar

The border is previewed in the lower field.

The four outer edges are marked in this field with small angles. To edit an outer
margin, click in the appropriate position between the small angles.

For tables there are two additional pairs of brackets indicating the horizontal and
vertical lines between cells. Click in the center of the preview field to define a
border for both horizontal and vertical lines.

The selected border elements will be indicated by black triangles. If you now
choose a line style or a color, it will be applied to the selected part of the border.

If you select an empty line in the preview, that is to say, if, of the three conditions

"non

"Line", "Gray Line" and "No Line", the condition "No Line" appears, this means
that the relevant part of the border will be deleted.
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Clicking repeatedly on an element in the Borders dialog will switch between three
alternative modes:

The element is displayed as a Clicking OK will apply the format to the
line element.

The element is displayed as a If you click OK, the object will remain
thick black line unchanged.

The element is not displayed Clicking OK will delete the element.

Use the Borders floating toolbar

Suppose you want to use the following table border for your document:

Berlin New York London
Germany USA Great Britain
Spree Hudson Thames
> 3 Mio Citizens > 7 Mio Citizens > 6 Mio Citizens

1. Place the cursor at the position in your document where the table is to be
inserted.

2. Choose Insert - Table to open the Insert Table dialog, and insert a table of the
required size, e.g. 3 columns and 5 rows.

3 O Select the whole table, press (Ctrl)(A) twice, then click the Borders icon
on the object bar. On the floating toolbar click the icon at top left, which
means "No Border".

4. Now, with the mouse, select the whole of the first row, open the context menu
and choose Table to open the Table Format dialog.

5. Open the Borders tab page.
6. In the line field select the required line thickness, e.g. 2.50 pt.

7. Inthe large Line arrangement field, click once in the area between the two
bottom angles (see illustration) and then on OK.
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Table Format

Tablel Text Flow | Columnz Burdersl Background I

Line arrangement Line: Spacing to contents
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1.00 pt Right 0.10crm =

400 pt Top 0.10cm =

I SO0 pt
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1.10pt
260 pt ¥ Synchranize
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— i
| Biack =]
Shadow style
Position IE Iﬁ Iﬁ IE
[jstatize m
Calor I- Gray j

Ok I Cancel | Help | Reset |

8. Now select the middle column of the table and again open the Table Format
dialog by choosing Table in the context menu.

9. Under Line arrangement, click the areas representing the right and left lines
(see illustration).

10. In the Style field select the required line thickness and click OK.

11. Select the bottom row of the table and again open the Table Format dialog by
choosing Table in the context menu.

12. In the Style field select the required line thickness, previously 2.50 pt, and in
Line arrangement click the areas representing the top and bottom lines.

13. Click OK. Now the table is finished.

Chapter 3  Creating Text Documents With StarOffice Writer 71



Making Text Superscript and Subscript

You have the following options for superscripting or subscripting text:
= Use the keyboard shortcuts Ctrl+Shift+P and Ctrl+Shift+B.
= Choose Format - Character - Position.

= Use the icons: Open the context menu of the text object bar, choose Visible
Buttons and on the submenu mark Subscript and Superscript. You will now
see the icons on the text object bar.

Making text superscript/subscript while typing
Suppose you want to type 1 m? (superscript 2):

1. Type 1 m2. After the 2, press the space bar or another key defining the end of a
word.

m2 automatically becomes m?, if this replacement pair is entered under Tools -
AutoCorrect/AutoFormat on the Replace tab. You can add other items to the
list.

2. After the automatic replacement, carry on typing as normal.
Suppose you want to type H,O with a subscript 2:

1. Type the H.

2. Press Ctrl+Shift+B.

Ctrl+Shift+B is the keyboard shortcut for subscript text, Ctrl+Shift+P for super-
script text.

3. Type the 2.
4. Press the keyboard shortcut again.

If you are at the end of a paragraph, there is an even easier way: Press the right
arrow key once.

5. Type the O.
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Applying subscripts/superscripts retrospectively

Suppose you want to change H20 to H,O with a subscript 2. Either use the key
shortcut above or the following method via the menu command:

1. Select the character that you want in subscript/superscript. In this example you

should select the 2.
2. Choose Format - Character. This opens the Character dialog.
3. Click the Position tab.
4. Select Subscript and click OK.

The 2 now appears in subscript.

Writing in Uppercase or Lowercase

How can text be changed to uppercase or lowercase letters?

You have the following options for re-formatting text in uppercase or lowercase.
Decide whether you want to apply a font effect to the text for display and printing

purposes only, or whether you want to replace the characters permanently.

» Display in uppercase: Select the text and choose Format - Character - Font
Effects tab, and under Effects select Capitals.

» Display in lowercase: Select the text and choose Format - Character - Font
Effects tab, and under Effects select Lowercase.

» Convert to uppercase: Select text, then choose Format - Case/Characters -
Uppercase.

= Convert to lowercase: Select text, then choose Format - Case/Characters -
Lowercase.
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Moving Text Sections in Documents

1. Select the text that you want to move.

2. Place the mouse pointer in the selected text, then press the mouse button and
keep it pressed.

3. Drag the mouse until a symbol appears next to the pointer, indicating that the
selected area will be moved. In addition, a gray text cursor moves with the
mouse pointer, indicating where the selection is to be inserted.

Mouse Pointer Shape Meaning
%WE Moving
Copying

If you do not want to move the text, but rather only copy it, press Ctrl while
performing this action. This is indicated by a plus sign next to the mouse pointer.
You can press and release the Ctrl key as often as you like - the action applies to
the condition prevailing at the time you released the mouse button.

Resetting Font Attributes While Typing

You may want to apply direct formatting while you are typing text. After that you
may want to reset all formatting and continue entering text in the default format.

Enter the text using direct character formatting, then press the right arrow key
once to revert to the default Paragraph Style. Now, continue entering text at the
end of the current paragraph.

Example

Suppose you want to type the words "This is written in bold italic", and set the last
two words to bold italic as you are typing. Type "This is written in ", then click on
the Bold and Italic icons on the Object Bar. Type "bold italic". Then, instead of
clicking on the two icons again, simply press the right arrow key once. Then carry
on typing in the default format of the paragraph you are in.
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Chapters in Navigator

In long documents, you can use the Navigator to obtain an overview and change
the sequence of chapters or their level in the hierarchy of chapters and sub-chap-
ters. The only condition is that you must apply "Heading" Paragraph Styles to the
chapter headings (or enter the Paragraph Styles you have chosen for your head-
ings under Tools - Outline Numbering).

Navigator as variable-size window or minimized

» Hold down (Ctrl) and double-click on the gray area at the edge of the Navi-
gator, e.g. next to or below the icons.

This docks the Navigator against the Navigator

side of the window, or turnsitbacktoa & @ st 2 =] & =
variable window whose sizeand posi- 'm@E | 0§ EEE & =

tion you can select for yourself by drag- _

ging and dropping with the mouse. The E%mn —
size and position are automatically Haw to Register - Dverview
remembered. Double-click to switch o ;iesrt::rt];"::“:”;;g’f‘;;:ﬁj;g:ﬁce
between docked and variable Navigator Registration Dialog

windows. Inztalling StarOffice

General Installation Tips

. . . Camments about uzsing this User's Guide

» Inside the Navigator, double-click on a Starting Star Office under Windows
heading to move the cursor to the rele- Starting StarOffice under LINI

vant point in the text. lEontents af the !nstallatmn co
Single User Installation

Ihstallation Requirements

. Drag and dI‘Op to change the sequence Starting the Single Uszer Installation Setup
of chapters. You can also do this by The aetup Dalogs
. . Selecting the installation directory =
clicking on the Promote Chapter and | s rnmnnm:r|
. 4 8
Demote chapter icons. The content of
the chapters and of the relevant sub- |getup Guide StarDffice (active) [

chapters is of course also moved.

» If you want to move the chapter headings without moving their contents, drag
and drop while holding down the (Ctrl) key. (The Drag Mode icon only affects
drag and drop behavior between Navigator and document). When using this
function, switch on Heading Levels Shown by clicking on the relevant icon in
the Navigator, so that you can see what is happening in the document.
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Quick Formatting Using the Adjacent Paragraph
Format

Maybe you have two consecutive paragraphs with different paragraph formats
and you would like them both to be formatted the same way. This is the quickest
method:

1. Delete the paragraph mark (nonprinting character) between two paragraphs.
2. Press Enter.
Both paragraphs now have the same format with the same Style.

=  When you delete by going to the end of the first paragraph and pressing the
Delete (Del) key, the second paragraph will be brought into the first (known as
"deleting to the right"). If you then turn the text back into two paragraphs by
pressing the Enter key twice, the second paragraph assumes the format of the
first.

= If you delete by going to the beginning of the second paragraph and pressing
Backspace (above the Enter key), the second paragraph stays the same (known
as "deleting to the left"). Then press Enter to get two paragraphs with the
format of the second paragraph.

Using Sections

The sections in text documents mark off blocks of text for special purposes.
Thus there are the following areas:

= Sections of text with a different number of columns than the master text

= Sections that are protected from further editing

= Sections that are only to be shown under certain circumstances or not shown at all
= Sections that are to be inserted into a document as files or parts of files

= Sections that can be incorporated into other text documents via DDE

A section always consists of at least one paragraph. When you select a text and
define it as a section, it is automatically ended with a paragraph break.
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You can insert another text document as a section within a text document. A
section from another text document can also be inserted as a section. Sections
within a single document can also be linked to other locations.

To insert a new paragraph immediately before or after a section, place the cursor at
the very beginning or end of the section and press Alt+Enter.

Sections and Columns

=  Multicolumn section: A section can contain other sections. This feature allows
you, for example, to create a two-column section on a page of text, and then
create a three-column section within that section.

» Multicolumn page: The page format (Format - Page - Columns), which always
applies to all pages with the current Page Style, is independent of the sections.

» Multicolumn frame: You can also insert frames containing columns of text
which you can move freely around the page (from main toolbar, long-click to
open Insert floating toolbar, click Insert frame icon). For these frames, for
example, you can select that the text in the frame be positioned a certain
distance from the edge of the frame (Choose Format - Frame - Wrap).

Inserting Sections

1. Place the cursor at the point where you want to insert a new section, or select
the text that is to form a new section.

2. Choose Insert - Section. You can define other settings for the section in the
dialog.

3. Click Insert.

You can insert other documents or sections from other documents. In this case,
Links must be marked. You can enter a file name in the text box, or click "..." to
search for a file. You can select a named section of the document in the Section
combo box.

When you open a document that contains linked sections, you will be asked
whether you want to update these sections. If you answer yes, the current versions
of the linked sections will be updated.
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Under Windows you can also use the DDE method to keep inserted sections up to
date with the current status of the original files.

You can also have sections as files in HTML documents. The inserted sections are
automatically updated when StarOffice loads the relevant HTML document again.
Web browsers show the content of the sections as at the time the content was
saved as an HTML document.

Editing Sections

You can edit the sections in your text document by choosing Format - Sections.
This dialog allows you to protect sections, unprotect sections, reveal hidden
sections, change the conditions and remove sections, i.e. turn them back into
normal text.

Formatting Text With and Without Styles

Text often appears monotonous unless you apply visual effects to it. To give struc-
ture to the text, to emphasize individual words, quotations or references and to
break up solid areas of prose, it is usual to apply special formatting to sections of
text.

Direct Formatting or Formatting With Styles

When working with StarOffice, you can choose between direct formatting and
formatting with Styles to apply text attributes such as bold, italics, font type and
font size. A direct format is obtained by directly applying a certain attribute to a
text area. For example, by clicking the Bold icon on the text object bar you directly
apply the bold format to a selected text area. On the other hand, you can use Styles
to indirectly apply attributes to text. A Style is a named set of default settings for
formatting text.

Direct formatting is more appropriate for one time use. If, for example, you want
to make a word bold, just position the cursor in the word and click the Bold icon.
This works quickly and intuitively.

Indirect formatting with the help of Styles is always preferable when you want to
format lengthy texts in a uniform way. Styles require more advance preparation,
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though. First you must create the Style, then you apply the Style to the text. Both
tasks are best done using the Stylist.

Assume you have formatted each of the headings in a long text with a 24 point
Helvetica font. If you need to change all the headings to a 20 point Times font and
in bold, it would take a long time to make each change by hand. But if you had
defined the format as a Style, for example with the name "Headl", and applied it
to the headings in the document, you would simply have to change the "Head1"
Style, and all headings would be automatically modified accordingly.

The Style Concept in StarOffice

Styles for characters, paragraphs, frames, numbered lists and pages (or cells in
table documents) are always saved with the document. If you want, you can copy
the Styles of a text document into another text document (see page 99). You can
choose whether to overwrite or not replace Styles of the same name.

You can turn any document, together with the Character, Paragraph, Frame,
Numbering and Page Styles it contains, into a template (see page 80). When you
open a new document based on this template, all those Styles are available to you.

When you start StarOffice for the first time, certain predefined Styles apply to all
document types. When you open a new text document with File - New - Text
Document, for example, a new, blank document will be opened with these fixed
settings, which together form the default template. If you want, you can turn any
document into the default template (see page 95). The Styles that you have defined
and that are now contained in the default template will then apply to all new
documents.
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The Styles in the Stylist

Open the Stylist by choosing the Stylist command from the Format menu or by
pressing F11 or by clicking the icon on the function bar. All the Stylist functions are
explained in StarOffice Help.

Paragraph Styles

Character Stylez

mEOOR 7> %5 {8 ) ) £ 0 & 2 Gz e
Complimentary dose - Bullet Symbaols -
Caption Characters
First line indent
Hanging indent Definition
Heading Orop Caps
Heading 1 Emphasis
Heading 10 Endnote anchor
Heading 2 Endnote Characters
Heading 3 Example
Heading 4 Foothnote anchar
Heading 5 Footrote Characters
Heading & LI Indes Link, ;I

| Automatic | fa =l

At the top of the Stylist are icons for selecting the Style type that you want to
display. These are, from left to right: Paragraph, Character, Frame, Page and
Numbering Styles. The main area of the Stylist lists the available Styles of the
selected type. But you only see the Styles of the active Style category, specified in
the list box at the bottom of the Stylist.

For example, if the word "Automatic" is selected in the list box, StarOffice offers
the Styles that make sense in the current context. If you want to see all the Styles of
a Style type, select "All Styles" from the list box.

Paragraph Styles

Select Paragraph Styles, if not already selected, by clicking the Paragraph
Styles icon in the Stylist. You will then see a list of Paragraph Styles.

Double-click an entry in the list of Paragraph Styles. The paragraph in which the
cursor is positioned will now be formatted with that Paragraph Style. Double-
click in the Stylist on another Paragraph Style, and the formatting of the current
paragraph changes accordingly.

If you want to format a paragraph as a heading, for example, here is how to do it:
1. Type the line to be formatted as a heading and press the Enter key.

2. Set the cursor in the line.
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3. Open the Stylist, for example, by pressing the F11 key.
4. Double-click the Paragraph Style "Heading 1".

This one paragraph now has the paragraph format "Heading 1". If you want to
know which attributes are included in this paragraph format, click "Heading 1" in
the Stylist, then right-click to open the context menu. Then choose Modify to open
the Paragraph Style: Heading 1 dialog, which tells you everything about the prop-
erties of this Paragraph Style.

If you don't want to modify this Paragraph Style, close the dialog by clicking the
Cancel button. But, if you want to modify this Paragraph Style define the corre-
sponding modifications and close the dialog with the OK button. These modified
settings will now apply to all paragraphs (old and new) having the "Heading 1"
Paragraph Style.

You can also apply the changes to all Paragraph Styles that are derived from the
Paragraph Style "Heading 1". The Paragraph Styles "Heading 1" to "Heading 10"
are all hierarchically derived from the Paragraph Style "Heading". If you switch to
a hierarchical view in the Stylist, by selecting "Hierarchical" from the list box at the
bottom of the Stylist, you can immediately see which Style ranks above and below
another Style in the hierarchy.

If you change the left indent to 2 cm in the Paragraph Style "Heading", for
example, you will change the left indent for all Paragraph Styles "Heading 1" to
"Heading 10" to 2 cm. Changes that you make directly in one of the Style dialogs
have priority over the properties "inherited" from higher-ranking Styles. If you
choose the Organize tab in the Paragraph Styles dialog, in the Based on list box
you will see which superordinate Style the current Style is derived from.

Character Styles

In the previous illustration, the Stylist (seen on the right) displays a list of available
Character Styles. These Styles do not modify the whole paragraph, but only the
single word in which the cursor is currently positioned or a selected text range.

You can use or modify the supplied Styles, or you can define your own Styles and
use those. The best way is to start by selecting a Style from the Stylist (with a single
click), which you then use as the starting point for creating your own Style. You
then merely have to enter the properties that are different from the selected Style,
since the other properties are "inherited" from the parent Style.
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The following table contains a selection of Styles.

Style Type Attribute Selection

Paragraph Styles  Indents and Spacing, Alignment, Hyphenation, Tabs, Font,
Language, Initials

Character Styles ~ Font, Font Size, Language

Frame Styles Position, Anchoring, Borders

Page Styles Header, Footer, Margins, Columns

Numbering Styles Numbering Type, Outline, Bullets, Assigning Numbering
Styles

Hierarchical Styles

The Styles can be hierarchically linked to each other. You can derive one defined
Style from another, so that the new Style contains only the changes not found in
the "basic" Style. If you decide to change the "basic" Style later on, the text in the
deduced Style will also be changed accordingly.

For example, the Paragraph Style "text body" uses the font "Times" in "12" point.
Derived from this Style, you have created a Style called "indented text", in which
you only added a left indent but the font and size stay the same. If at some point in
time you decide to change the font in "text body", the font will automatically
change in the "indented text" Style.

Sticking with this example, if you redefined the left indentation in the "text body",
it would have no effect on the paragraphs formatted with "indented text" because,
in the hierarchy, the more closely associated format always has priority.

Numbering Styles

Using the corresponding icons from the object bar, you can easily assign bulleting
and numbering to your text document. As with the icons for bold, italic, etc. you
assign direct formatting which is not already determined by the Style.

When working with Styles, the Stylist offers various Numbering Styles. You apply
these by double-clicking the name of the Style.
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Creating New Character Styles or Paragraph Styles

You can create a new Style on the basis of an existing Style as follows:

1.

5.

First of all, apply new, direct formatting to any characters or any paragraph,
which will become the Style. To do this, either use the text object bar or open
the Format menu and choose Character or Paragraph.

Select the text or paragraph containing the new formatting. For words or para-
graphs, simply position the cursor in the respective word or paragraph.

At the top of the Stylist, click the Paragraph Styles icon if you want to create a
new Paragraph Style. Click the Character Styles icon to create a new Character
Style.

At the top of the Stylist, click New Style from Selection. This opens the Create
Style dialog.

Enter a name for the new Style and click OK.

As you can see in the Stylist, you have created a new Style in the "Custom Styles"
group. Now you can use your new Style for indirect formatting in your document.

You can also create a new Style without using an existing Style as the starting
point:

1.

2.
3.
4.

In the Stylist, choose whether you want to create, for example, a Paragraph
Style or Character Style, by clicking the respective icon.

Call the context menu of the Stylist (click right mouse button).
Choose New...

Enter the data for the desired Style and close the dialog with OK.

The following example demonstrates how to define a Paragraph Style for a
subtitle. Assume you have several subtitles in your text which you want to format
with a custom Paragraph Style.

1.

Position the cursor in a paragraph in the text that you want to format with the
new Paragraph Style.

Apply a Paragraph Style to the paragraph as an initial format. This way you do
not need to define all of the attributes yourself. For example, double-click on
the "Heading 1" Paragraph Style in the Stylist.
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The paragraph is now formatted as "Heading 1." Now you can make any desired
changes, such as formatting the subtitles to appear in italics.

1. Select the entire paragraph. It will appear highlighted.

2. Modify the type of characters by selecting an italic font in the Character dialog
(Choose Format - Character - Font) or by clicking the Italics icon on the text
object bar.

3. In the Stylist, click on the New Style by Example icon and enter a name for the
new Style in the dialog box, for example, "Head1." Click OK.

Do you know how to apply a Paragraph Style? Place the |—_|
cursor in the paragraph and double-click the Style name pefat

in the Stylist. If the desired Style already exists in the
document, you can also select it from the Apply Style combo box on the object
bar.

Creating Document Templates

To make your user-defined Paragraph or Character Styles available in other docu-
ments, you need to create a template. The template contains all the Styles from the
current document.

1. If you want, you can delete all text from the current document, leaving only the
Styles.

You can apply Styles from one text document to another text document:
Choose Format - Styles - Load.

2. Call the menu command File - Templates - Save.

3. In the dialog Document Templates, select the category in which you would
like to save your template. In the New Template text field, enter the name for
your template and click OK.

Later, you can open a dialog with File - New - Templates and Documents and
select a template to be used in creating a document. The defined Text and Para-
graph Styles will then be available for the new document.

84 StarOffice 6.0 User's Guide * March 2002



The Advantages of the Stylist

Above we have shown you how to apply the Styles in the Stylist to your text, and
you also know how to apply your own Styles. Styles have the advantage that they
do not have to be redefined every time. In this way, you can apply the desired
formatting to your document quickly and easily. But the Stylist offers you still
more possibilities.

Formatting Multiple Paragraphs

In the work described in this section, you applied the same Paragraph Style
"Heading 1" to several paragraphs. The Stylist can save you a lot of time on this
task:

1. In the Stylist, select the Style you want to apply to multiple paragraphs by
clicking the Style once.

2. At the top of the Stylist, click on the Fill Format Mode icon. The mouse
pointer changes to a symbol indicating this mode as soon as you move
back into the document.

3. Click once on every paragraph in the text you want to apply the selected Style to.

4. Finally, to switch off this mode, click the Fill Format Mode icon again or press
the Escape key.

Easy Way to Change a Style

After having formatted all headings with the new "Headl" Style, you may decide
that it would look better if the headings were spaced with slightly wider gaps
between the letters. Select the longest heading and increase the defined spacing
until it fits onto one line without a break. Now you want all other headings to be
spaced in exactly the same way. In this case, simply modify one of the paragraphs
formatted with the "Head1" Style, and then add the changes to the Style in the
Stylist, making it valid for all paragraphs of this type. Here are the steps:

1. Inthe text, select the longest heading formatted with the "Head1" Style. Click
three times in the heading to select the entire line.
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2. Make the desired changes. To lock the character spacing, as in this example,
choose Format - Character, or choose Character from the context menu for the
selected line. In the Character dialog, click the Position tab and in the Spacing
list box select "Expanded". In the spin button, increase the spacing to make the
heading wider. Close the dialog with OK.

3. You have now additionally used direct formatting on one of the headings
formatted with the Style "Head1". All direct and Style formatting should now
be added to the "Head1" Paragraph Style. This Style is still selected in the
Stylist.

4. =8 At the top of the Stylist, click the Update Style icon. All headings
formatted with "Head1" will be automatically reformatted with the
modified Style.

When creating a new Style, you can also make it adapt to any changes automati-
cally. In the properties dialog for the Style, click the Organizer tab and mark Auto-
Update. Now, if you change the formatting of, say, a paragraph formatted with
this Style, the formatting of all other paragraphs with the same Style will be auto-
matically changed as well.

Page Styles and Page Numbers

You want to create a text document without a page number on the title page, with
lowercase or uppercase roman numerals on the pages of the table of contents (you
do not know how many yet), and then you want to start the page numbering with
arabic numerals.

Different Page Styles are the StarOffice Writer equivalent of "section changes" in
other text programs.

It is best to have page numbers in footers or headers rather than in the running
text, to make sure that the page numbers do not change their position when text is
inserted or deleted. You can do this for example by following these steps:

1. Create new Page Styles
2. Apply Page Styles

3. Edit Page Styles
4

. If you want, you can format the page numbers in the Paragraph Style of the footer.
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Do not use the Offset box under Insert - Fields - Other - Document tab to change
the page number of a page. The offset is only used, for example, at the end of a
page to display the number of the next page, i.e. to offset the display; it does not
change the page number itself.

The manually entered page number (in contrast to the automatically numbered
page numbers) is an attribute of that particular page. This property is set as direct
formatting in the first paragraph of that page.

Create Page Styles

1. Open the document in which you want to enter or change the page numbers.
You can also begin with a new text document, although you need to first enter
some text and page breaks to be able to follow the steps described here.

2. 4% Open the Stylist.

3. Select the Page Styles view in the Stylist.

Page tyles

i > %= iE
Mew...
Modify...
Lielete..

Foothnote

HTML

Index

Left Page

Right Page

o =

4. Call up the context menu of one of the Page Styles and select the New...

command.

You will see the Page Style dialog with the Organizer tab page. The cursor
will be blinking in the Name text box where you can directly enter the name of
the first new Page Style.
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Page Style i

Organizer | Pagel Background | Headerl Footerl Borders I Columns | Footnote I

Mame I'I'ltle Page

Mext Style IUntitIedl N
Linkedjwith | E
Lategory IEustom Styles j
Containz

Width: 21.0cm, Fixed height: 29.7cm + From top 2.54cm. From bottom 2.54cm + Page
Description: Arabic, Portraitleft + Mot register-true

Ok I Cancel | Help | Rezet |

5. Enter Title Page and press the Enter key. You can change the properties of the
new Page Styles later.

6. In the context menu of the Stylist click the New... command again and define
the Page Style with the name "Table of contents".

7. Repeat the whole procedure again for the new Main text Page Style. Of course,
the names used here are only meant as examples. In a real situation you would
naturally enter the names of your choice.

You have now created the three new Styles.
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Applying Page Styles

1.

Place the cursor on the first page of your document. Double-click the Title
page entry in the Stylist.

So, now you have assigned the first page this Page Style. To confirm this, you
will see the name Title page in the Page Style field on the status bar below. By
the way, you can also edit (double-click) and assign existing Page Styles via the
context menu of the Page Style field on the status bar.

If, however, you now scroll through the pages of your document, you may
notice that the Title page Page Style has been applied to every page. If all the
pages had been defined by the Standard Page Style, they are now all defined
by the new Style. Page Styles always apply to all preceding as well as
following pages, unless a page break occurs with a change of Page Style.

On the Organizer tab page, if you enter a Next Style for a Page Style, this
means that after a page break (whether you enter it manually or it occurs auto-
matically) the Next Style will be taken as the Page Style. In the example
described here, for the Page Style Title page you can select the Next Style
Table of Contents. The Table of Contents Page Style is then always applied to
the next page after the title page. This saves you from having to go through the
procedure described below involving the Manual Break dialog.

Please note that you should always choose the Table of Contents Page Style as
the Next Style to follow the Table of Contents, since you cannot be sure how
many pages long your Table of Contents will be.

Now place the cursor at the beginning of the page where the Table of Contents
should begin. Go ahead and enter a manual page break with a change of Page

Styles.
Choose Insert - Manual Break. The Insert Break dialog appears.

Select as Type the Page break option. In the list box select the Table of
Contents Page Style which will then begin at this point in your document.
Click OK.

Place the cursor at the beginning of the first line in your main text.
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6. Choose Insert - Manual Break. The Insert Break dialog appears.

Insert Break

Twpe
. Line break
o LColumn break Cancel

{* Page break

il

Hel
Style 2=

IMain Text

7. Select as Type the Page break option. In the combo box, select the Main text
Page Style, which should be applied after this point. Mark the Change page
number check box and select the new page number 1. Now click OK.

# If you want headers or footers to contain different contents on the right and left
sides, you just have to unmark the Same content left/right check box.

Under Format - Page - Page, you can select the page layout "mirrored". This lets
you define an inner and an outer margin for the text.

The left and right pages of the main text often have different Page Styles so that,
for example, the left pages have a header, but the right ones do not. There are
already Left page and Right page Page Styles provided for you. You can use
these instead of Main text. The first page of the main text is page 1 and contains
the Right page Style; assign the Left page Style as the Next Style and vice versa.
You can assign these Styles to the corresponding pages in the Stylist context
menu with the Modify command. On the Organizer tab page, you can choose the
Next Style.
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Editing Page Styles

Your new Page Style with the name Main text should have a page number in the
middle of the footer. Follow these instructions:

1. Select the Main Text entry in the Stylist, open the context menu of that entry
and choose Modify.

You see the Page Style: Main Text.
2. Go to the Footer tab. Mark the Activate Footer check box. Click OK.

You will now see an empty footer on the document page. Use the mouse cursor
to select it.

When the cursor is placed in the footer, choose Insert - Field - Page Numbers. The
page number will appear in a gray field. To have "Page" precede the page number,
place the cursor in front of the field and enter "Page".

= C(lick the Center icon on the object bar to center the current paragraph.
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Page Breaks as Paragraph Formats

In the first paragraph of the main text, direct paragraph formatting was automati-
cally applied, determining that the text automatically begins on the new page 1.
This will also apply if no text exists after the manual break on the new page. To
check this for the first paragraph after the manual break, choose Paragraph... from
the context menu (not Edit Paragraph Style, since this is a direct formatting

attribute for a paragraph).

Background
Ihdents & Spacing | Aignment  Text Flow | Mumbering I Tabs I Drop Caps | Eorders

at: |2 3: [Charactets at:[ine end
At |2 3: [Eharactiens atlimne begim

Hyphenation
[ Automatically

ID 3: T aeirntan e o f cofsecutive ypiens

Options

v Break. o Page

& Eefore

¥ with Page Style
r Don't separate lines
r Keep with next paragraph

r Orphan control

[~ widow contral

. Column

" After

Page nurmber

|2 3: Lifres
|2 3: lifes

o |

Cancel | Help | Reset |

If you want a particular paragraph to be on a new page with a new Page Style,
then that would be a property of that particular paragraph. Assign this property

under Format - Paragraph - Text Flow.
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Changing the Format of Page Numbers

The page numbers can, like other text attributes, be specified as either direct or as
a property of the Page Style. The direct format, however, should only be used in a
few instances. When direct formatting, you edit the the field directly as follows:

1. Double-click the field with the page number. You will now see the Edit Fields:
Document dialog.

Edit Fields: Document

Type Select Format

Page numbers AL A A
3. 3. a3 Carcel |
A B C
abc
arabic (1 23 Help |
Az Page Style

Rarmaty 1 1111y

Offset

Jo

2. Select the field format. Now click OK.

Normally, you would determine the page number format as a property of the Page

Style:

1. Open the context menu on the page and select Page. Then you will see, for
example, the Page Style: Default dialog. Instead of "Default", the title bar of the
dialog contains the name of the current Page Style.

2. Go to the Page tab.

3. In the Numbering combo box, determine how you want the numbering to look
on all pages with this Style. Then close the dialog with OK.

4. Now select the As Page Style format for the field which shows the page
number (see the description of direct formats above ).
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If you want to change other properties in the footer, e.g. the font, you need to edit
the Footer Paragraph Style so that the changes will apply to all footers.

= Place the cursor in the footer. Call the context menu and choose Edit Paragraph
Style.

If you want to increase the spacing of the footer from the text above, this is a
format attribute of the Page Style:

= Change the Page Style in the Stylist with the Modify... command in the the
context menu. In the Page Style dialog you can determine the width and height
of the footer.

Page Styles Summary

If you assign a Character Style or Paragraph Style, first select the text in which
want to use that Style and then double-click in the Stylist on the name of the Style.
The method is a bit different with Page Styles.

A Page Style is always a property of the first paragraph of a page. This can be the
tirst paragraph of the current page or the first paragraph of a previous page. Not
every first paragraph has the Page Style attribute. StarOffice Writer searches for
the Page Style attribute of the current page by starting at the cursor's position and
going back towards the beginning of the document, checking each first paragraph
of a page to see if it has a Page Style as attribute.

You can set another Page Style using, for example, the context menu of the field in
the Status bar which displays the current Page Style . If you do this, StarOffice
Writer will search backwards until the first paragraph at the beginning of a page
has been found in which the current Page Style will be applied. This paragraph
will now be given the newly selected Page Style and this Style will be applied from
this point up to the end of the document or until a new first paragraph containing
another Page Style is found.
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Defining Default Templates

If you find you always have to change the formatting of your new documents to
suit your requirements, it is time to use a separate template, known as the default
template. This default template will be used every time you open a new text docu-
ment, by choosing File - New - Text Document, for example.

1.
2.

Create or open a document that contains your favorite Styles and formatting.

You can delete the text of the document if you want, so that only the Styles and
other settings remain.

Save the document as template by choosing File - Templates - Save.
Doing so saves the document as a template in staroffice6.0\user\template.
Choose File - Templates - Organize.

In the left list box of templates, double-click "Default". The name of the default
template you have saved will appear. Click the name.

Open the context menu and choose Set as Default Template. Close the dialog.
This template will now be used as the default template.

Reset Default Template

1.
2.

3.

Choose File - Templates - Organize.

Open the context menu of one of the list boxes or open the submenu of the
Commands button.

Choose Reset Default Template. This command opens a submenu in which
you see every document type for which you have selected a default template.
Select the document type you want to assign the default settings to.
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Templates and Styles

The templates in StarOffice are files you can use as basis for creating your own
documents. Templates can contain text, logos, other graphic objects etc. In addi-
tion, every template contains a large number of Styles, all of which can be viewed
in the Stylist. For each document type (text, table, drawing, presentation etc.), a
single template file is defined as the default template (file): this is always used
when, for example, you create a new (usually empty) document with File - New.

Nearly every document type has its own template. Lists of the different templates
for text documents can be found in the StarOffice Help about text documents. The
same applies to templates for presentations and spreadsheets.

Choose Format - Styles - Catalog to open a dialog offering different Styles
depending on the nature of the current document. For example, if you opened a
text document and call this command, the dialog will look like this:

o E o E 7> %= I8

Complimentary close -
Default

First line indent
Hanging indent
Heading

Here, as in the Stylist, you can select the type of Styles from a list box, modify the
Styles belonging to this type, delete Styles you have created yourself and create
new Styles. However, you can also click Organizer. Then you will see a dialog
with contents similar to the following illustration:
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Template Management x|
7 Default y toText | B, Circuit Board: Close I

£3 Business Correspondence Untitledi

£ Education Untitled2 Comrands v |
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3 Formz and Contracts Help |
3 Miscellaneaus

T3 Other Business documerts

£3 Perszanal Carrespondence And O
3 Presentation Backgrounds

3 Presentations

5 | | ﬂ Address ook |
ITempIates j IDocuments j File.. |

You can use this dialog to copy the Styles contained in a particular template or in a
particular document individually to another document. Look at the illustration. If
you double-click the name of a folder in the left window you will see below it all
the templates contained in that folder. Double-clicking one of these files causes the
two categories Styles and Configuration to appear. Once again, double-click to
open a list of the objects contained. But in the case of a document you will only see
the Styles that are actually used in that document.

If you drag and drop elements from one dialog page to the other, you can see how
the mouse pointer shows where you can drag the contents to. Either the mouse
pointer is a circle with a line through it, in which case you cannot move the content
to that place, or the mouse pointer has an insert line that tells you the place where
the content will be moved to when you release the mouse button.

Creating New Styles From Selections
You can create a new Style by copying an existing Style, as follows:
1. Open the Stylist.

2. In the document, select a formatted text or paragraph the format of which you
want to adopt as a Style.

3. In the Stylist, click the icon:

%E New Style from Selection
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A new Style from Selection can also be made by using drag and drop:

1. Choose the type of Style to be used (Paragraph Style, Character Style, etc.) by
clicking the corresponding icon at the top of the Stylist.

2. Select that part of the paragraph, text or object which is to form the basis of the
new Style.

3. Drag this to the main Stylist area and release the mouse button over a free area
when the insertion line is no longer visible.

Transferring Formats With Fill Format Mode

Applying a new Style in Fill Format Mode:

1. Open the Stylist.

2. In the Stylist, select the Style you want to copy.
3. Click the Fill Format Mode icon.
4

. Position the watering can on the object to apply the Style currently selected and
press the mouse button.

There is an exception to this procedure: when applying a Character Style in the
Fill Format Mode, select the character with the mouse (watering can) while
holding down the mouse button instead of only clicking.

To quit the fill format mode, click the icon again or press Esc.

f If the watering can icon is activated, a right-click anywhere in the document
* undoes the last watering can action. Be careful not to accidentally right-click and
thus undo actions you want to keep.

Updating Styles From Selections
This is how to update a Style:
1. Open the Stylist.

2. In the document, select a formatted text or paragraph the format of which you
want to adopt as a Style.
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3. In the Stylist, select the Style you want to update (single-click, do not double-
click!)

4. In the Stylist, click on the icon:

H Update Style

You can also update the Style by using drag and drop:
1. Select the Style to be updated in the Stylist.

2. Select the section of paragraph text, the format of which is to be used to update
the Style selected in the Stylist.

3. Drag the text into the main Stylist area and release the mouse button when you
see the insertion line above an entry.

The Paragraph Style directly above the insertion line is assigned the new format.

Copying Styles into Documents

You can load the Styles from another document into the current document.

Load Styles

LCategories Templates oK

Business Correspondence Cancel
Education

Finances

Forms and Contracts

Iizcellaneaus

Other Business documents

Personal Correspondence And Documents ;I

Help

bl

v Text r Frame r Pages r Mumtbering r Dvernrite Fram File...

Choose Format - Styles - Load to select a document. Choose whether to apply Text
Styles (i.e. Paragraph Styles and Character Styles), Frame Styles, Page Styles

and/or Numbering Styles, and whether you want to overwrite the Styles in the
current document with the new ones.

In the dialog, click the From File button to start a dialog in which you can make a
selection like under File - New - Templates and Documents.
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Entering and Formatting Text
Automatically

This section deals with certain automatic functions that help you enter and format text.

Turning Off AutoCorrect Function

By default, StarOffice Writer corrects many common typing errors. However, you
may not always want this. You can undo any automatic correction immediately
after it is made, for example by pressing (Ctrl)(Z)

Below we indicate the places in StarOffice where you can turn off automatic
corrections (and turn them on again):

Quotation marks are replaced with Custom Quotes
1. Open a text document.
2. Choose Tools - AutoCorrect/AutoFormat.

3. Click on the Custom Quotes tab. Unmark Replace.

Sentences always begin with a capital letter
1. Open a text document.
2. Choose Tools - AutoCorrect/AutoFormat.

3. Click on the Options tab. Unmark Capitalize first letter of every sentence.

A word is replaced with another word
1. Open a text document.
2. Choose Tools - AutoCorrect/AutoFormat.

3. Click on the Replace tab. Look for the word pair and delete it.
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Three identical characters will become a whole line

When you enter three of the following characters at the start of a new paragraph

and press Return, a complete line of various thickness will result: - _ =* ~ #

1. Open a text document.

2. Choose Tools - AutoCorrect/AutoFormat.

3. Go to the Options tab. Unmark the Apply border check box if you no longer

want this automatic conversion to occur.
The line is a border of the previous paragraph. Choose Format - Paragraph to
edit or delete it.

Automatic Spellcheck

From within a text document, click the AutoSpellcheck on/off icon on the main
toolbar. All words marked as incorrect by the spellchecker will then be under-
lined in red.

Click on words underlined in this way with the right mouse button. A context
menu then appears.

The context menu often provides a list of suggested words, one of which you
may click on to select it. The suggested word then replaces the word under-
lined in red.

If you replace the wrongly typed word using the AutoCorrect function in the
context menu, the word pair will be entered in the AutoCorrect replacement table.
To call up this table, choose Tools - AutoCorrect/AutoFormat - Replace tab.

If the word underlined in red is correct, you can place it in your custom dictionary
using the Add command.

To exclude words from the spellcheck:

1.

SARE- A

Select the words.

Open the context menu of one of the words.
Choose Character.

Choose Format - Character - Font tab.

Now select the language [Nonel].
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Using AutoText

&g StarOffice Writer contains an AutoText function which allows you to
*" compose whole texts for letters, faxes or any other documents by entering
predefined or user-defined shortcuts.

To insert AutoText you can:
= Enter the shortcut for an AutoText item and press the F3 key.

Some predefined AutoText blocks are provided. For example, enter DT and
press F3 to insert a dummy text which can be used to check the look of a page
filled with text (and other objects). Enter FN and press F3 to insert a StarOffice
Math formula with sequential numbering at the right border.

= Choose Edit - AutoText.

AutoText
I Gispiay remainder of name 23 suggestion while typing:
e )
Mame |BW, with Filr Roll Shortcut | BWF
FEDERICK FE%AM FLE
B Business Cards, Home (3 %x 2 '8 — Help |
B, with Film Rall L
B, with Initials AutaText W |
B with Cuill Pen ) —
By, Circuit Board Categaries |
B, Classic =
B, Cogwheels
B, Elegant i |
B, Gray Circle
BW, Modern ;I

Save links relative to

- File system - Inketmet v Shiow presisw

The AutoText dialog contains a number of AutoTexts. As you will see, AutoTexts
can even contain graphics and tables.

= Long-click on the Edit AutoText icon on the main toolbar and select an Auto-
Text.

= You can also use the AutoComplete function. Directions for using this function
are found in the StarOffice Help.
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Move the mouse pointer to the AutoText that you want to insert in the text at the
cursor position. When you release the mouse button, the text is inserted.
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Defining AutoText

Write the desired text. It may contain formatting and embedded graphics. Select
the text. Now, click briefly on the AutoText icon in the Main Toolbar. In the large
list box, select the category (e.g. 'Default’), assign a name for the new text compo-
nent in the text box and correct the abbreviation if necessary. You may now save
the text component via AutoText - New; afterwards, you should close the dialog.

Using AutoText in Networks

You can use AutoTexts from different directories. An example would be in a
typical StarOffice network installation:

Read-only "company AutoTexts" could be in a directory on the server, while you
write and read your own, user-defined AutoTexts in your own files.

= Choose Tools - Options - StarOffice - Paths. Double-click AutoText.

Two paths have been entered here. The first path takes the AutoTexts from the
server installation. The second path takes the AutoTexts from your user directory.
If two AutoTexts from two different directories have the same name, StarOffice
will use the AutoText from your user directory.

Printing AutoTexts

To print a list of all AutoTexts, use a macro from the StarOffice Basic Gimmicks
library. The macro lists all AutoText names and shortcuts in a new text document.
Choose Tools - Macro, double-click "Gimmicks" in the right list of the Macro
dialog, select "AutoText" and then click Run.
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AutoText With AutoComplete

1. Inthe AutoText dialog, mark Display remainder of name as suggestion while
typing.

AutoText B
I Dispiay remainder of name as suggestion while typing:
Cloze
Mame |BW, with Film Rall Shortout IBWF _—l
FEDERICK FEXAMPLE
B Busingss Cards, Home (3% 2 '%) — Help |

B, with Film Roll

i, with Initials
B, with CQuill Pen

AutaText b4

T

B, Circuit Board —
B, Claszic £ |
B, Cogwheels |
B, Elegant Path..

B, Gray Circle

B, hodern j

Save links relative to
I File system I Internet v Show preview

2. When you enter a word in the text that exists as an AutoText name, after the
third matching letter is typed a Help tip will appear containing the whole
name of the AutoText.

3. Press Enter to insert the AutoText.
If you see a Help tip containing several AutoText names that begin the same way,

use (Ctrl)(Tab) to scroll forwards and (Shift)(Ctrl)(Tab) to scroll backwards
through the AutoText names.
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Exceptions in AutoCorrect

If AutoCorrect corrects a word you have entered, and if you do not want this
correction, you can restore the word using the Undo function. This word will also
be placed in the list of exceptions in AutoCorrect, if AutoInclude is marked in the
AutoCorrect dialog. (By default it is marked.)

Example

By default, AutoCorrect automatically corrects two capitals at the start of a word.
But in the case of product names and the like you might actually want two initial
capitals.

Suppose you have a new product called "ESt". AutoCorrect will automatically
change this to "Est".

= Press (Ctr])(2).

This will undo the automatic replacement and the word "ESt" is automatically
included in the list of exceptions in the AutoCorrect Dialog.

See also the functions for automatic numbering of headings, starting on page 126.
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Moving Text, Drawing Lines

If you want your text to look good as well as read well, you can customize its
appearance for maximum impact.

Inserting, Editing and Linking Text Frames

Inserting Text Frames

Place the text in a text frame. On the Insert floating toolbar, you can use the Insert
Frame Manually icon to do this.

=

T EE=ROBRE=

To insert text in a text frame after you have already typed it in, proceed as follows:

1. Select the text that is to be in the frame.

2. = Long-click the Insert icon on the main toolbar and open its floating
toolbar. On the Insert floating toolbar, press the mouse button on the
Insert frame manually icon. While still pressing the mouse button, move the
pointer down a bit and select the desired amount of columns by highlighting
them in the window that appears. Release the mouse button when you have
selected the desired number.

3. If you now move the mouse cursor into the text document, a cross-hair symbol
indicates that you can drag open a frame. If you decide not to do so, press the
Escape key to change the cursor back to a text cursor again.

4. With the crosshairs, create a selection frame which defines the new location for
the paragraph.

The selected text is now automatically deleted from the normal, continuous text
and inserted in a text frame.

Click the edge of the text frame to select it. You can recognize a selected text frame
by the eight handles that appear, four of which are located in the corners and one
in the middle of each side.
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Editing Text Frames

Once you have selected a text frame, you can change it by dragging and dropping
with the mouse button pressed. By dragging the edge (not one of the handles), you
move the whole frame. Dragging one of the handles changes the size of the frame.
The corner or side opposite the one you are dragging stays in the same place.
Dragging a handle on one of the sides enlarges or compresses the text frame in one
direction only, whereas dragging a corner handle enlarges or reduces it in both
dimensions. If you hold down the Shift key while dragging one of the eight
handles, the frame will retain the same proportions, in other words the side ratios
remain constant.

The options in the context menu of a selected frame allow you to make further
adjustments.

Arrange 3 |

n O+ Left
Anchor v +0+ Centered

Wirap + =0 Right

4+

o o # Frame.. O Top
v Caphion.. Certer

Bottom

O+ *0+ +|

% ut Strg+X
Copy Strg+C

From the context menu of a text frame you can select, for example, the Alignment
relative to other frames, drawing objects, graphics etc. Use the Wrap submenu to
choose whether and on what side the normal text of your document should wrap
around the text frame. Clicking on Frame in the context menu is the same as
choosing Format - Frame from the menu bar. This opens a dialog giving you access
to all properties of the frame.

The functions available in text frames are the same as in text documents. In addi-
tion to text, frames can contain pictures, multiple columns, etc.
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Linking Text Frames

You can link several text frames to each other even when they are on different
pages of a document. The text will automatically flow from one to the other.

1. Inorder to create a link, click the edge of the frame you want to link. Eight
handles will appear around the edges.

2. g Click the Link icon on the object bar.

3. Click the frame that is to be linked.

When a linked frame is selected, any existing links are indicated by a connecting line.

The height of a frame that is linked with a subsequent frame is automatically
fixed. The height is no longer automatically adapted to the content of the frame.
Only the height of the last frame of a chain can be adapted to the text content.

If you click the Link of the object bar when a frame is selected, the cursor changes.
It can now display two icons: a chain with an arrow if two frames can be linked by
clicking, or a chain with a stop sign if linking is not possible where the cursor is
positioned. A note is displayed in the status bar in each case, e.g., why linking is
not possible.

& Linking is only possible from one frame to the next. That means that a
frame that is already linked to a frame cannot be linked to another frame
which follows. Therefore, the link icon cannot be activated if a frame
already has a next link. Also, two frames can only be unlinked with the
Unlink Frames icon from the first frame.

The linking of frames is not allowed under the following conditions:

» The target is not empty. An (automatically) captioned frame is not empty and
can therefore not be the target of a link.

» The target already has a previous link.

» Source and target are in different sections, e.g. one frame is in a header and the
other frame is in a footer.

» The source already has a next link.
» Source and target are the same.

= Closed chains or chains from the inside out or from the outside in are also not
permissible. The latter is the case if you inserted a frame into another frame and
want to link them with each other.
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Using Text Animation

Suppose you want to compose an application with colored, animated text suitable
for a simple web site. This is how to do it:

1. Open a new, blank StarOffice Writer document.
2. Select Format - Page to select a background for the whole page.

3. @@ Open the Draw Functions floating toolbar from the main toolbar and
click the Rectangle icon.

4. Create a rectangle in the center of the page:
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5. Open the context menu for the selected drawing object.
6. Choose the Area command to assign a color or pattern to the area inside the

rectangle.

7. On the left side of the Area tab page, select the option Gradients and choose
e.g. "gradient 4". Close the dialog with OK.

*®

Open the context menu once more and select the Line... command to define
the border properties of the rectangle.
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10.

11.

12.

13.

14.
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For the line, choose a color and a width. Close the dialog with OK.

Double-click in the middle of the rectangle and type your text. It does not
matter if the text extends beyond the width of the rectangle.

Click again on the border of the rectangle in order to select it. Then open the
context menu and select Text.

In the Text dialog, click the Text Animation tab. Under Text Animation select
Effects and in the combo box the option "Scroll Through". On the Text tab
page you can set the distance from the left and right borders. (The border of a
frame goes half inside and half outside.) Click OK.

Now you just have to undo the selection of the rectangle by clicking on another
place in the document. In a moment the text animation will start to run.

To change the size of the animated text, select the rectangle again and double-
click in the center. Now you can select the text and apply a larger font size.
You can also select a suitable text color by opening the context menu and
choosing Character.

You can enlarge or reduce the page view either by choosing View - Zoom or via
the context menu of the scale field on the status bar. If the screen display is to be
refreshed, press Shift+Ctrl+R.
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Drawing Lines in Text

You can incorporate lines in your text, the angle, width, color, etc. of which can be
defined however you'd like.

Create a horizontal line suitable, for example, for a website, by applying the
preset Paragraph Style Horizontal Line. Place the cursor on a blank line and
double-click the Horizontal Line Style in the Stylist. If the entry for horizontal
lines is not visible in the list of Paragraph Styles, switch the view in the Stylist
from "Automatic” to "All Styles".

You can draw a line above, beside or below a paragraph by choosing Format -
Paragraph - Borders. This function is explained in detail in the StarOffice Help.

To define the line attributes and direction yourself, use the Line drawing object
as follows:

On the main toolbar, long-click the Show Draw Functions icon to open
the Draw Functions floating toolbar and click the Line icon. The mouse
pointer changes to a cross-hair symbol with a line beside it.

In your document, click where the line should begin, hold down the mouse
button and drag to the point where you want the line to end. If you also hold
down the Shift key, you can draw only horizontal, vertical, and diagonal lines.

Release the mouse button once the line has the desired direction and

length. You can then draw more lines. End this function by pressing the
Esc key or by clicking the Selection icon from the Draw Functions floating
toolbar.

After clicking the Selection icon, you can select all of the lines at the same time
by clicking each line while holding down the Shift key. This multiple selection
enables you to assign all of them a common color, width or any other attribute.

These lines and other draw objects which you insert in text are not defined in the
* Internet page description language HTML and are therefore not exported directly
into HTML format. Instead, they are exported as graphics.
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Editing Text With FontWork

The FontWork program module is used for graphical text effects. This is what you
do:

1. T Open the Drawing Functions floating toolbar from the Main toolbar and
click the Text icon.

2. Draw a text frame on your page, and then type in text,
for example "FontWork".

3. Choose Format - FontWork. This opens the FontWork
window, from which you select the desired effects:

4. Click the upper-left icon with the semicircle to display
the text as a curve.

ID.DDcm 3:
ID.UU-:m 3:

5. Click Vertical in the Shadow options. Specify 0.10 inches
for the x-axis shadow distance. The text should now

appear similar to the illustration.
<) 5 el =] (52

6. Since the first and last letters are not very easy to see,
insert two blank spaces before and after the text. Double- D [0 =
click the text, edit it, and then click outside the object. 0 ID.DDcm =]

7. When you select the FontWork object, eight handles | [
appear. To change the size and shape of an object,
simply drag one of the handles in the desired direction. Additionally, you can
copy the finished object to the clipboard and paste it from there into other
documents where you can also modify its size and other attributes.
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Aligning Text With Lines

Aligning text with freeform line

1. Draw the freeform line (Draw Functions floating toolbar).
2. Double-click on the line.

3. Enter the desired text or copy it from the clipboard.

4. Choose Format - FontWork.
5

. Click for example on the Rotate icon.

Aligning text with straight lines

If you want to slant a text, so that it runs precisely from one point on the text page
to another point, this is what you do:

1. Using the draw functions, draw a straight line from one point to another.
2. In the list box on the object bar, select the line style "Invisible".

3. Double-click on the line, which is now invisible (but you can still see the two
ends). Double-click exactly between them.

4. Enter the text, then click outside the line object.
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The Navigator

In addition to the Stylist, which is designed to help you format documents (see
page 80), another important feature of StarOffice that you will find helpful is the
Navigator. On the one hand, the Navigator helps you navigate, or move accu-
rately, to the parts of your document you are looking for. On the other hand, the
Navigator provides a lot of information about the content of the document in a
clearly understandable way.

In text documents, the Navigator provides you with complete lists of all graphics
and tables in your document. In addition, you can double-click the list entry in the
Navigator, and by doing so, go straight to that place in your document.

But the Navigator can do a lot more. For example, in texts that you have structured
through the use of headings, you can change the sequence and hierarchical levels
of whole chapters and sub-chapters quite easily by clicking the appropriate icons
in the Navigator.

Activate the Navigator by clicking the corresponding item in the Edit
menu.

You can dock the Navigator to the edge of a window by dragging its title bar while
pressing the Ctrl key. You can dock and undock the window by pressing Ctrl and
double-clicking in a vacant area of the Navigator.

Jumping From One Object to Another in Text

Clicking the Navigation icon at the top of the Navigator opens a "mini navigator"
which you can, for example, use to move in your document from one graphic
object to the next one or to the previous one. To do so, you need to first drag the
blue title bar of the navigation floating toolbar to position it outside of the Navi-
gator. Now the arrow icons will be visible at the right side. Just click the
"Graphics" icon and then either the Previous graphic or Next graphic arrows. This
also works for tables, frames, sections, and so on.
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With the help of the Navigator, you can "jump" to any object in your docu-
ment. Another way to achieve the same result is to use the Navigation
button (the "mini navigator") found in the vertical scroll bar at the bottom
right-hand side of the document window. This is a floating toolbar that can
be positioned anywhere on your screen. In the Navigation window, click
the object type you want to jump to, and then click one of the arrow icons to
go to the previous or next object of this type in your document.

| ke

If the Navigator arrows in the scroll bar (in the lower right corner) appear
black, you can scroll through the pages of your document. If the arrows
appear blue, you can scroll to each object of the same category you have
selected in the Navigator (e.g. to each table or bookmark, and so on).

In the main section of the Navigator there are entries for Headings, OLE objects,
Hyperlinks, References, etc. A plus sign in front of one of the entries means that
there are corresponding objects in the selected document and that you can have
the list of the objects of this type shown by clicking the plus sign or double-clicking
the entry. Double-click one of the object names to display it in the document and
move the cursor to that position.

By the way, the names of the elements in the Navigator can be easily modified: In
the context menu of the name (right-click the name) you will find the command for
renaming.

Jumping From One Reminder to Another

In the Navigator, you can also set temporary reminders that stay in effect until you
close the document. This method makes it easy to move between particular loca-
tions in the document, for example, if you want to look up or add something later.

1. Position the cursor at the position in the text where you want to set a reminder.

2. Click the Set Reminder icon in the Navigator. The reminder will not be visible
in the document.

3. If you want to jump to a reminder, select the Reminder entry in the "mini Navi-
gator". You can now move through the reminders by clicking the Previous and
Next arrows.

116 StarOffice 6.0 User's Guide * March 2002



Jumping to a Specific Page

One of the functions of the Navigator is to allow you to move quickly to particular
pages in long documents. There is a very handy way of doing this, even if you
have not yet opened the Navigator. All you need do is double-click the current
page number on the status bar, and the Navigator opens. Double-clicking the
display field on the status bar closes the Navigator again.

At the top of the Navigator is a spin button where you can enter the number of the
page you want to go to. After entering the page number, press Return and the
cursor is automatically placed on that page.

There is also a keyboard shortcut to do the same thing. Press Ctrl+Shift+F5 to
move the cursor to the spin box in the Navigator where you directly enter the
desired page number. Now press the Enter key.

You do not have to change to the new page with the cursor. Enter a page number
in the Navigator spin box and wait one or two seconds. The respective page will
appear. If you enter another number, that page will appear. The cursor is placed
on the page only when you press the Enter key.

Other Navigator Features

The Navigator can be very helpful, particularly in longer documents, when you
want to know about the objects in the document. For example, if you have an

HTML page open, the Navigator tells you at a glance which hyperlinks the page
contains. (Any hidden hyperlinks will be shown as well, without reference text.)

The Content View in the Navigator helps you organize and rearrange whole chap-
ters with their sub-chapters, provided you have formatted them with the Styles
defined for the chapter numbering. For detailed instructions, refer to the StarOffice
Help.
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Indexes and Tables of Contents in
StarOffice Writer

In your StarOffice Writer documents you can have any number of predefined or
user-defined indexes. For example, you can have a table of contents, alphabetical
index, illustration index or bibliography.

Defining Index/Table of Contents Entries

Before creating an index or table of contents, determine which entries in your
document you want included. For entries in the table of contents, the simplest
method is: Assign the Paragraph Styles "Heading 1" to "Heading 10" to your head-
ings, according to the hierarchical level. The table of contents can then be created
automatically. (You can also add paragraphs formatted with other Paragraph
Styles to the table of contents, see Creating a Table of Contents.)

First define entries for other indexes as entries in the document.

1. Select the word or words in your document which are to be listed in the index.
Several words can be selected by holding down the Shift key if they are listed
one after the other, or by holding down the Ctrl key if they are spaced apart.
When selecting a single word you only need to position the cursor in the word
to select - it does not need to be highlighted.

2. Enter the selected words in an index by choosing Insert - Indexes - Entries. If
you want a different term to appear in the index, you enter it in the Entry field.
For example, you could enter "dictionary, defining", whereas only the word
"dictionary" appears in the text.

You can define all similar words in your text as entries by choosing Insert -
Indexes and Tables - Entry and marking Apply to all similar texts.

If you want to include the words in a separate index with a name of your choice, in
the Insert Index Entry dialog, click on the New User-defined Index icon. This
opens a dialog in which you can enter a name for the index. This name later
appears as the title of the index. You can change the title of an index without the
content of the index changing.
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Editing or Deleting Index and Table Entries

The defined index entries are shaded gray in the document, so you can recognize
them more easily. However, the shading will not be printed. If you prefer not to
display the shaded entries on-screen either, you can switch the highlighting on or
off with View - Field Shadings.

Inzert Index Entry

Selection
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1. To edit an entry, place the cursor immediately before or inside this entry.
2. Then choose Edit - Index Entry.

3. You can alter the text in the Entry text box.

4. Click on the Delete button to delete this entry from the list.

If you modified the displayed text of the entry, the altered text will be inserted into
the generated index. You will now only see a thin gray mark in the document
where the entry was. If you want to edit an entry such as this, place the cursor
directly after the thin mark and choose Edit - Index Entry.

Use the arrow buttons in the Edit Index Entry dialog to switch to the next or
previous entry of the same index type.
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Creating a Table of Contents

1. Place the cursor where you want to create the table of contents.

2. Choose Insert - Indexes and Tables - Indexes and Tables. The Insert
Index/Table dialog appears. Click the Index/Table tab and select "Table of
Contents" as Type (the first time you start this dialog, this tab page and type are
already selected).

3. Click on OK if you want to generate the table of contents from the headings and
entries you have defined.

4. If you want to insert additional paragraphs of another Paragraph Style into the
table of contents, mark the Additional Styles check box and click the icon next
to the box. A dialog will open where you can define which Paragraph Styles are
also to appear in the table of contents and on which level they are to be shown.

If you later want to change the headings, rearrange their sequence or insert new
chapters, you will have to update the table of contents:

« Place the cursor in the table of contents. Call the context menu and choose
Update Index/Table.

*  You can also select Tools - Update - All Indexes and Tables to update all the
indexes and tables of contents in a document.

Creating Alphabetical Indexes

1. Place the cursor where you want to create the index.

2. Choose Insert - Indexes and Tables - Indexes and Tables.
The Insert Index/Table dialog appears.
3. On the Index/Table tab, select "Alphabetical Index" as Type.
4. To generate the alphabetical key word index using the default settings, click OK.

You have the options, of whether letters under which entries exist, are to be high-
lighted as subtitles ("alphabetical delimiter" in the Entries tab) or if case-sensitivity
is to be taken into account when sorting and much more.

If you want to change the formatting of the individual lines in the index, it is best
to edit the Paragraph Styles in the Stylist. All direct formatting will be overwritten
at the next update.
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Using a Concordance File

If required, you can add index entries from a concordance file. A concordance file
contains a number of key words and information as to how these words are to be
seen in an index.

1.
2.
3.

Choose Insert - Indexes and Tables - Indexes and Tables.
On the Index/Table tab page, select the type Alphabetical Index.
Mark the Concordance file check box.

Click the File button to select whether to open, create, or edit a concordance
file. Further information on the structure of the concordance file can be found
in the StarOffice Help.

Creating User-Defined Indexes

You can create as many user-defined indexes as you want. Click the icon New
User-Defined Index in the dialog Insert Index Entry and enter the name of the
new index. After this you can carry out the entries for this new index. Finally you
can create the index in your document:

1.
2.

Position the cursor on the place where the user-defined index is to be created.

Choose Insert - Indexes and Tables - Indexes and Tables.... The dialog Insert
Index/Table will appear. Select the "user-defined" type on the Index/Table tab
page. If you have given the user-defined index a name select this name from
the Type list box.

Select the index type in the list box and click OK to generate the index from
marked entries.
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4. Mark Styles and after clicking the ... button choose one of the Styles used in the
document to generate the index from all those paragraphs having the corre-
sponding Style.

5. Mark the other check boxes under Create from if you want to create the index
from all the objects of a certain type.

6. Enter a fitting title into the Title field for the index (you can alter the title
directly in the document but it will be overwritten when the index is updated).

The names of the objects will appear in the index. You can assign names to the
objects on the Options tab of the corresponding property dialog.

Creating Bibliographies
A bibliography entry could be shown in the text as follows: "Smith [Smith 1995]
has also carried out research on this matter". The reader will then know that more

detailed information can be found in the bibliography under "Smith 1995", for
example, the full name of the author, title of the book, publisher, etc.

You can decide which details should appear in the bibliography by going to the
Insert Index/Table dialog, choosing the Type "Bibliography" and clicking the
Entries tab.

For example, you will use different entries for magazine articles than for entries
concerning books. For this reason the bibliography database is divided into
different types of sources of literature.

To edit the bibliography database, choose Tools - Bibliography Database.
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You can also generate a new record in the Insert Bibliography Entry (by clicking
the New button), but these "ad hoc" records will be saved only in the current docu-
ment, not in the Bibliography Database, and then only if you actually insert the
relevant new entry.

When saving a document with bibliography entries, all information belonging to
the entries will automatically be saved in a hidden field. In this way, all data will
be included when you distribute the document, for example, on a disk. It does
not matter whether the bibliography was created in the document or not.

1. To insert the bibliography entries into the text, position the cursor in the text
where the entry is to appear and then choose Insert - Indexes and Tables -
Bibliography Entry. The following dialog will appear:
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2. You should first decide if you want to select the entry from the records
contained in the bibliography database or from the entries that are contained in
the current document (and which can differ from entries of the same name in
the bibliography database).

An entry in the document content can be identical to an entry in the Biblio-
graphy Database. The entry in the document has precedence.

3. If the required entry already exists as a data record select it in the list box Short
name and click Insert.
If the desired entry does not yet exist, create a new entry.
If you use the New button to do this, you can define a new record, but this will
only be recognized in the current document.

If the record should be included in your bibliography database, choose Tools -
Bibliography Database, enter the new record and then insert the bibliography
database entry in the document.
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Updating, Editing and Deleting Indexes and Tables
of Contents

1. Place the cursor in the index/table and call the context menu.

2. The context menu contains commands for updating, editing or deleting the
current index or table of contents.

By default they are protected from changes. You can only set the cursor in an
index or table of contents when under Tools - Options - Text Document -
Formating Aids the Cursor in protected areas - Enable check box is marked.

To now edit the index or table of contents, call from the context menu the
command Edit Index/Table. In the dialog that appears, go to the Index/Table
tab page and unmark the Protected from manual changes check box.

Editing the Format of an Index/Table of Contents

In the Insert Index dialog, on the Entries tab you can also edit the format of the
index. Amongst other things, you can alter the way in which entries, tab stops and
page numbers are arranged. On the Styles tab you can assign other Paragraph
Styles. For detailed instructions, refer to the StarOffice Help.
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You can automatically assign hyperlinks to the entries in the table of contents.

» To do this, go to the Entries tab page, place the cursor in the structure row
before the entry <E#>, click the Hyperlink button, then place the cursor after
<E> and click Hyperlink again.

In the list of contents of your document you can then click a hyperlink to go straight
to the first occurrence. The table of contents must be generated from headings.

Indexes Covering Multiple Documents

There are several ways of creating an index covering multiple documents:

» You can create an index in each individual document, then copy the indexes
into a document and post-edit them.

» A more elegant solution is to select each individual index as a section (Insert -
Section) and insert these sections in a common index document as a link.

» If you are working with a master document, common indexes are possible
across all sub-documents.

More information about master documents can be found starting on page 132.
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Headings and Numbering

In large text documents, you can profit from the automatic functions for headings
and numbering,.

Numbering and Numbering Styles

You can apply numbering in your text either as direct formatting or by using a
Style, just as you can with other paragraph attributes such as "Justified" or "Line
Spacing". The icons on the numbering object bar and the options in the Format -
Numbering/Bullets dialog apply direct formatting. Direct formatting is also
applied when you use automatic numbering via the AutoFormat/AutoCorrect
function.

# The AutoNumbering of AutoCorrect is not applied to the Styles listed in the
Stylist under "Special Styles".

You can apply a particular Numbering Style to certain Paragraph Styles or apply
the Numbering Style directly to the paragraphs. In those cases, you can take
advantage of the paragraph formatting system for numbering as well.

When you change the Numbering Style, all numbering that you have created with
this Style will be automatically reformatted. The Numbering Styles are described
in the StarOffice Help.

Turning Bullets On and Off

This is how to turn a bulleted list on and off:

1. Place the cursor in a paragraph that you would like to mark with a bullet
symbol, or select a number of paragraphs.

2. = Click on the Bullets on/off icon on the Text Object Bar. The paragraph or
~ paragraphs will be formatted as a bulleted list.

3. »= Inan existing bulleted list, if you click on the Bullets on/off icon, the
"~ paragraphs will turn back into normal text.
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4. 4 Inabulleted list, clicking on the icon at the far right of the object bar
changes the Text Object Bar to the Numbering Object Bar. You can also
select which bar to display by opening the context menu on the object bar.

The Numbering Object Bar contains icons for moving and rearranging
numbered paragraphs.

You can select further settings for the bulleted list in which your cursor is posi-
tioned with the Format - Numbering/Bullets dialog.
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If you would like a different bullet symbol, you can select one under Format -
Numbering/Bullets - Options by clicking on the button with three dots, which
opens the Special Characters dialog. You can only see this button if you selected
"Bullet" in the Numbering combo box.
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Turning Numbering On and Off

This is how to turn numbering on and off:

1. Select the paragraphs you want to number.

2. Click on the Numbering on/off icon on the Text Object Bar. The para-

graphs are formatted as a numbered list.

i
z

In an existing numbered list, if you click on the Numbering on/off icon,
the paragraphs will turn back into normal text.

P

Like bulleted lists, the best way to control numbered lists is with the icons on the
Numbering Object Bar. When you move a numbered list down a level, the subor-
dinate numbered list at this level starts from one again. Using the Show sublevels
box, you can select which previous levels should be included in the numbered list.
To access these options, choose Format - Numbering/Bullets - Options.

Example

1. Line one
2. and line two
1. and a sublevel of line 2

In this example, the list is not fully numbered. The full number of the last line with
the sublevel of 2. would be 2.1.

Outline Numbering

To number your headings automatically, choose Tools - Outline Numbering. By
default, the Paragraph Style "Heading 1" is assigned to the highest level of Outline
Numbering.

= If you select a Numbering Style from the Number combo box, then all para-
graphs in your document that have the "Heading 1" format will have consecu-
tive numbers placed in front of them.

If you have created your own Paragraph Styles and you would like to use these for
your headings, you can apply the styles in this dialog to the individual levels.
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1. Suppose, for example, that you have created a Paragraph Style "Head1" to be
used for headings of level 1. In the Level list box select 1 and in the Paragraph
Style combo box select Head1.

2. Click OK.

Now, all paragraphs with Head1l applied to them will be listed in the Navigator
under "Headings".

You can rearrange the chapters in the Navigator if you want to change their order
or their place in the hierarchy and thus also the numbering.

=
Lol

P
LT [
LT LT
iy gy

» Click on one of the icons Promote Chapter, Demote Chapter, Promote Level
and Demote Level, or

» move the chapter heading in the Navigator using the mouse.

The numbering of all affected chapters is adjusted automatically.
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Automatic Numbering /Bullets

StarOffice also automatically recognizes bullets and numbering during entry if you
have previously chosen Format - AutoFormat - While Typing. Numbering that
uses Roman numerals is also recognized and continued. The list can start with any
value: e.g., you do not have to begin with .

An example with Roman numerals:

1. Enter I. (with a period after it), also followed by a space and text. You can also
use a right parenthesis here instead of a period.

2. Press the Enter key to create a new paragraph.

3. The new paragraph will begin with IL, i.e., the Roman numeral for two. Enter
some text, press the Enter key and the next paragraph will begin with III. and
so forth.

You can begin your Roman numbering with any numeral you want, for example,
with ci (corresponds to 101), followed by cii (102) etc.

Numbering Illustrations by Chapters

To number illustrations by chapter, so that illustrations are labeled "Illustration

1.1", "Illustration 1.2", etc. in the first chapter and "Illustration 2.1", "Illustration
2.2", etc. in the second, proceed as follows.

1. Organize your document by chapters if you have not already done so. Choose
Tools - Outline Numbering to number the chapter headings that you have
formatted, for example, with the Paragraph Style "Heading 1". Select the
"Heading 1" Style from the Paragraph Style list box and the option "1, 2, 3,.."
from the Number list box below it.

2. Select the first illustration you want to number.
3. Choose Insert - Caption....

4. In the dialog that appears, select Illustration as the category and Arabic (12 3)
as the numbering. You also can enter your caption text in this dialog.

5. Click Options. Specify the chapter numbering in the Number Range Options
dialog. For this example, select option "1" under Level and specify the separator
you want for chapter-wise numbering. Click OK.

6. In the Caption dialog, click OK. Your illustrations are now numbered by chapters.
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Do the same for all other illustrations in your document.

The numbering occurs automatically: All illustrations within one chapter level are
numbered, and you can enter at which chapter level you want the numbering to
switch in the Number Range Options dialog.

Choose Tools - Options - Text Document - General, and under Caption mark
the Automatic check box. When you click the button next to Object selection, the
Caption dialog appears. This is where you can, for example, determine that from
now on all illustrations in text documents receive a caption automatically.

Defining Number Ranges

To number all the elements in your document that belong together, for example all
the notes, warning messages, quotations, etc., you can define a separate number
range, or sequence, for each group.

Example

1. For example, type "Quote Number" in front of the first quote.

2. Choose Insert - Fields - Other....

Fields
Dacumert I References | Functions | Docinformation  “Wariables I Databasze |
Type Selection Format
Set variable Drawing A B C
Shows wariable llustration abc
OOE field AL AL AR
Inzert Formula Table 4. 33. 333
Input field Text Faman D

Murnber range

Set page wariable
Shows page variable
User Field

Murnbering by chapter

Lewel INone hd l
SEparatar I

Quotation v | x |

Mame “alue

Ihsert I LCloze | Help |
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3. On the Variables tab page, select the "Number Range" field. For the Name,
enter "Quote."

4. Click Insert and close the dialog.

The "Quote" number range enables you to automatically number all the quotes in
your document. In the field Value, you can select a new initial value for the entire
number range. This is useful when you are dealing with a document in a series of
connected documents.

Number ranges and captions can be restarted at each chapter. In the Caption and
Fields dialogs you can choose the chapter level at which to begin renumbering.

Using Master Documents and Subdocuments

You can either create a new empty master document by choosing File - New -
Master Document, or create a master document from an existing document by
choosing File - Send - Create Master Document.

You can open a master document by choosing File - New - Master Document. The
new master document is opened as an empty text document. You will immediately
see the Navigator in global mode.

able of Contents
= Chapter 1
Chapter 2
Chapter 3

= Alphabetical hdex

The Navigator in master mode provides the functions you need for navigating and
editing. Double-click a document in the Navigator to load it for editing.

When opening an existing master document, note the extension ".sxg", which
distinguishes a master document from "normal" StarOffice Writer documents in
the Open File dialog. There is a sample master document provided with the
StarOffice samples.

v Now you can either enter text, e.g., for headings, or insert subdocuments,
" Dby clicking the icon Insert and choosing the desired entry Text or File.
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You can also insert a new document with the entry New document; in this case, first
enter a name and a path; after that, you can write the new document and save it.

Paragraph Styles you define and use in the subdocuments are automatically
adopted in the master document. If you save the master document afterwards,
these Styles will be available everywhere in the master document. The Styles
defined in the master document have priority over Styles with the same name in
subdocuments.

It is a good idea to base all subdocuments and the master document itself on the
same document template. If a new Style is needed in the documents now, you
simply have to add it to the document template and reload the master document.
Then the new Style can be applied to all documents automatically.

Use Page Styles, if you want all subdocuments to always start on a new page (e.g.
always on a new right page). We included a Page Style called "Right page" that
you can, for example, link to the Paragraph Style "Header 1". If you assign a page
break to the Paragraph Style "Header 1", every "Header 1" will always be at the top
of a right page. As the Next Style assigned to the Page Style "Right page" you now
choose "Left page" and vice versa.

Mumbering | Tabs I Drop Caps I Background | Eorders
Organizer I Ihdents & Spacing I Aignment  Text Flow | Font I Font Effects I Pozition
Hyphenation

r at: H haracters atine end

afs m [Shatacters ot e EEgi

lﬂ Il feEs off consecitive byphers
Options

[ Break &+ page " Column

o Before . After

|7 with Page Style IRjght Page 'l Page nurnber ID 3:

[ Don't zeparate lines

v Eeep with next paragraph

[ Orphan contral |2 3: lifies:
[~ widow control |2 3: lifies

ak I Cancel | Help | Reszet | Standard
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If the cursor is positioned in a text in the master document, the entry Text is
shaded gray because consecutive texts are always combined to one single text.
Between individual inserted documents, you can insert new text. The new docu-
ments or texts are always inserted above the current entry. However, you can
easily change their order with Drag&Drop or with the icons Move down and
Move up.

The inserted documents are inserted in the master document as protected areas.
That means that you cannot edit the documents within the master document. It is
possible, however, to navigate through the document with the cursor in order to
read them.

All indexes are created directly in the master document, i.e., in the *.sxg file. They
automatically include all subdocuments.

by If you change one or more subdocuments after creating an index, you
should update the indexes in the master document. To do this, click the
icon Update on the Navigator for master documents and select the entries
to be updated from the submenu.

References work between Master Document and subdocuments, as well as within
subdocuments, when these are definite in all documents involved. Therefore, if the
figures in a subdocument are numbered from "figure 1" to "figure 10", the figures
in the next subdocument can start with "figure 11).

If you want, you can save the master document together with all its parts as a
combined StarOffice Writer document. To do this, choose the command File - Save
as and choose a "normal" StarOffice Writer format in the list box File type.

When printing the master document, all subdocuments, texts, and indexes will be
printed.

You would like to know if a link exists for all subdocument? Position the mouse
pointer in the Navigator on the corresponding entry. The path information of the
original document will appear in a small window. If the file is no longer found
under the original path, the warning File not found is shown in red in addition
to the path.

@
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Importing Lists From Other Text Programs

Every text program has its own way of internally organizing bulleted lists and
numbering. If the import filter of StarOffice fails to evaluate this information
correctly, this is what you should do:

1.

3.
4.

Import the document from the other application (File - Open and then the Files
of type list box). If the bullets are not applied correctly, try saving the docu-
ment in the other application in RTF format and then import it.

Select the string of characters which now appears at the start of each list and
copy to the clipboard. This can be, for example, an asterisk * followed by a tab.

Start the Find & Replace dialog.

Insert the content of the clipboard in the Search for field.

You can ensure that the search text is only found at the start of the paragraph by
inserting " before the search text and marking Regular expressions.

5.

Click on Find All. All imported lists are now selected. Do not close the Find &
Replace dialog just yet.

Click on the Bullets on/off icon on the Object Bar. All the imported lists now
become StarOffice lists.

In the Find & Replace dialog, click on Replace All. Since the field is empty, all
selected strings consisting of, for example, asterisk * and tab will be deleted.

In the Numbering/Bullets dialog you can define the type of bullets for your
bulleted lists.

Changing Numbering via the Keyboard

If you want to move your numbering down a level in the hierarchy (or further
to the right), place the cursor at the beginning of the numbered paragraph and
press the Tab key.

Press Shift and Tab together to move an indented bulleted or numbered list up
one level (to the left).

If you want to insert a tab stop at the beginning of a numbered line, press
(Ctrl)(Tab).
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Interrupting and Continuing Numbering

In a series of automatically numbered paragraphs, we want one paragraph not to
have a number, as in the following example:

1. First paragraph.
2. Paragraph two.
An unnumbered paragraph.
3. Paragraph number three.

You can choose from the following methods:

Delete the automatic numbering

1. Select all paragraphs 1 to 4 and click on the Numbering on/off icon.

2. Place the cursor before the first character of the third paragraph.

3. Press the Backspace key to delete one character to the left.

The paragraph remains indented but loses its number. The fourth character now
has the number 3. This method also produces the desired result after saving in
HTML format.

Formatting the paragraph

1. Select all paragraphs 1 to 4 and click on the Numbering on/off icon.

2. Place the cursor in the third paragraph.

3. Click again on the Numbering on/off icon.

The third paragraph loses its number and its indentation. In HTML format, the
interruption creates two separately numbered lists.

Continuing numbering with a new starting value

1. Number paragraphs 1 and 2 with the Numbering on/off icon.

2. Place the cursor in the fourth paragraph.

3. Choose Format - Numbering/Bullets and go to the Options tab.

4

. In the Numbering combo box select "1, 2, 3 ...". In the Start at spin box select
the starting value - in this case 3. Click OK.
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Numbering Lines

» Select line numbering properties under Tools - Line Numbering.

Use line numbering to number the lines within your document. You can decide,
for the whole of the document, whether blank lines should be counted as well, and
whether lines in text frames should likewise be counted. You can decide the inter-
vals at which lines are numbered and insert separators between these intervals to
identify a particular line number. The line numbering appears on your screen and
is printed.

You can apply other line numbering properties to the paragraph (Format - Para-
graph - Numbering) or to the Paragraph Style. Doing it this way ensures greater
flexibility, as you can exclude a paragraph from the line numbering or restart the
numbering at a paragraph with any starting value.

Line Numbering for All Paragraphs
1. Choose Tools - Line Numbering.
2. Mark the Show Numbering check box.

Now all the paragraphs in the document will be numbered.

Line Numbering for Particular Paragraphs

1. Enable the line numbering for all paragraphs as described above.

2. Open the Stylist and click the Default Paragraph Style.

3. Right-click to open the context menu where you then choose Modify.
The Paragraph Style: Default dialog appears.

4. Go to the Numbering tab page.

5. Remove the mark in front of Include this paragraph in line numbering.

As all Paragraph Styles are derived from the Default Style, no paragraph will
be numbered unless a subordinate Paragraph Style was modified accordingly.

6. In the document, select all the paragraphs that are to be numbered.

7. Choose Format - Paragraph - Numbering, mark the Include this paragraph in
line numbering check box and click OK.
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Tables in Text, Calculating in Text

You can have tables and spreadsheets in your text documents. You can choose
either "normal" text tables, or spreadsheets imported from StarOffice Calc using
drag and drop or from a data source view.

Inserting Tables

There are various ways of inserting a table in your text document:

To insert a blank table with the mouse:
1. Place the cursor at the position in the text where you want to insert the table.
2. Point with the mouse to the Insert table icon on the Insert floating toolbar.

3. Press the mouse button and move the mouse down and to the right until the
required numbers of rows and columns appear in the preview area under the
icon.

4. Then release the mouse button. (If you want to abort the process, before
releasing the button move the mouse up or to the left until the word Cancel
appears in the preview area.)

To inserting a blank table via dialog:
1. Place the cursor at the position in the text where you want to insert the table.

2. Click briefly on the Insert table icon on the Insert floating toolbar. This opens
the Insert Table dialog.

Inserting from StarOffice Calc with the clipboard

1. Open your text document and a StarOffice Calc document from which you
want to insert a range of cells.

2. Select a range of cells from the spreadsheet. Copy it to the clipboard, for
example with (Ctrl)(C).
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3. Switch to the text document. You now have various options for inserting the
range of cells:

» You can use the "normal" command Edit - Paste or (Ctrl)(V) to insert the range
of cells as an OLE object. You can double-click on the OLE object in order to
edit it with StarOffice Calc tools and commands. Click outside the object to quit
edit mode.

» Choose Edit - Paste Special to open the Paste Special dialog, where you have
several options to choose from. The same options can also be found on the
submenu of the Paste icon on the Function Bar:

Options Is inserted as...

"StarOffice 6.0 Spreadsheet” or OLE object - as with (Ctrl)(V) or drag-and-
"Star Embed Source" drop

GDIMetaFile Graphic

Bitmap Graphic

HTML HTML table

Unformatted text Text only, tab stops as separators
Formatted text [RTF] Text table

DDE link Table structure and contents, without
(only under Windows) formatting. With updating.

Inserting from StarOffice Calc using drag-and-drop

1. Open your text document and a StarOffice Calc document from which you
want to insert a range of cells.

2. Select a range of cells from the spreadsheet. Click in the selected range of cells
and hold down the mouse button. Wait a moment.

3. Without releasing the mouse button, drag the selected range of cells into the
text document. If the text document is not visible, first move the mouse pointer
to the text document icon on the task bar and wait a moment until the text
document opens. In the text document, a gray insertion cursor follows the
mouse pointer, showing you where the table can be placed.

4. Release the mouse button when the gray insertion cursor is in the place where
you would like the table to be inserted.
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Deleting Tables

Suppose you want to delete a whole table from your text document. You have the
following options:

= Select from the end of the paragraph before the table to the start of the para-
graph after the table. Press (Del) or Backspace.

= Or place the cursor in the table, select all cells, for example by pressing
(Ctr])(A), open the context menu and select Row - Delete. This method also
works at the beginning or end of a document.

Inserting Paragraphs Before Tables at Start of Page

Suppose you have inserted a table at the very beginning of a text document or
immediately after a fixed page break, and now you want to insert text before this
table.

1. Place the cursor in the first cell of the table, right at the start of any content in
that cell.

2. Press Enter.
The table now moves down a line.

To delete this line before the table, place the cursor in this (empty) line and press
Delete.
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Preparing Tables in Text Documents

When you insert a table in a text document, you have several ways of formatting it.
Inserting Tables in Text Documents

1. For this example, open a new text document with File - New - Text Document.

2. Place your cursor at the position in the text document where you want to insert
a table.

3. Long-click the Insert icon on the main toolbar to open a floating toolbar which
contains the Insert Table icon. Drag the floating toolbar into your document.

Cancel

4. Click Insert Table and, keeping the mouse button pressed, drag to select the
desired amount of rows and columns. When you release the mouse button, a
table with the selected rows and columns will appear in your document.

Formatting Tables in Text Documents

A new table inserted into a text document will be pre-formatted. The first row will
have the Paragraph Style "Table Heading," and all other rows will have the "Table
Contents" Style. Text entered in the first row will automatically be bold and
centered. The following describes various formatting options that determine the
overall appearance of a table.

With tables in text documents, the first thing to note is that not all cells have to be
sized according to the general grid of rows and columns. You can easily merge
neighboring cells into a single cell, or split individual cells horizontally or verti-
cally. The relevant icons, called Merge Cells and Split Cells, can be found on the
table object bar. This gives you great flexibility in formatting the table.

In the Table Format dialog, you can decide on formatting attributes for a table.
Open this dialog either with the menu command Format - Table or the Table
command in the context menu.
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If you want to change the table background, for example, proceed as follows:

1. Select the cells to which you want to assign a background color.

2. Now, either choose Format - Table or click Table in the context menu of the
selected cells.

3. In the Table Format dialog, click the Background tab.

Table Format B3

Tablel Text Flows I Columnz I Borders Backgruundl

A coor - | For [cen i

Background calar

I Fill

-
AEEEEEEE
PFII—I—ITIII

I Fill

Ok I Cancel | Help | Rezet |

Notice the two list boxes at the top of the dialog. In the left box, you can choose
a color or graphics as the background. In the right box you can define whether
to apply the background to the selected cells, the whole row, or the entire
table. Cell formatting takes priority over row formatting.

4. Click OK when you have made your choice.

You can design your tables with even greater impact using thematically appro-
priate backgrounds. Background colors and graphics are always inserted behind
text and values in a table.

Graphics and other objects can also be inserted into the table.
1. Place your cursor in the cell where you want the object to appear.

2. To insert graphics, choose Insert - Graphics - From File.

142 StarOffice 6.0 User's Guide * March 2002



3. Inthe Insert Graphics dialog, select the desired graphics file. Click Open.

4. Click on the inserted graphic object and select the Graphics command in the
context menu (or double-click on the graphic object). In the Graphic dialog,
you can define various settings for the graphic and its function in the docu-
ment.

For example, you can define a text wrap and determine if the text should flow
around the graphic object and on which side. You can also set a hyperlink which
will then be loaded whenever the graphic object in the text document is clicked.
Furthermore, you can link the graphic object to a macro and in so doing, assign
various events to it. You could, for example, use this capability to program certain
functions, such as having a sound played when the mouse pointer touches the
graphic object.

Calculating in Text Documents

You can enter calculations in your text documents, both in running text and in
tables that you have created in the text documents.

» Press function key (F2) within any table cell or anywhere in the text to show the
formula bar.

= Within a table, all you have to do is enter an equals sign.

This is the signal that you want to enter a calculation formula. Press (F2) again or
(Esc) to hide the formula bar again.

To perform calculations directly within the text
» Type, for example, the following: "$10000 per year is $ per month."
» Place the cursor at the point where you want to insert the result and press (F2).

= You will now see the formula bar. The cursor is already waiting there for your
entry.

» Type 10000/12 and press Enter.

« The result of the calculation is inserted in the text.
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Calculating in Text

1.

2.
3.
4.

Place the cursor at the position in the text where the calculation result should
appear.

Press (F2) to display the Formula bar.
Enter the desired formula, for example (4+6)*100.

Press Enter or click on Apply to insert the result.

Use the Formula icon to perform more complex calculations. Clicking on this icon
opens a branched submenu from which you can select a formula. The formulas are
placed on the formula bar at the cursor position, and you are free to switch
between inputting formulas and values from the keyboard and via the Formula
icon.

As an example of a more complex calculation to be performed in a text, suppose
we want to calculate the mean value of three figures.

1.
2.
3.

6.

Display the Formula bar with (F2).
Open the submenu of the Formula icon.

Choose "Median" from the statistical functions. The input field will display
" =median."

Enter the first number and then a vertical slash (1) as the list separator.

Enter the second number, another separator and then the third number. The
input field may now show, for example, " =median 12122 34."

Press Enter, and the result appears in the text. It is inserted as a field.

Double-click on the field to edit it.

Calculating With Formulas Located in Text

If you already have a formula in your text, you can enter the result into your text
without using the Formula bar.

1.

In the text, select the calculation formula, which must not contain anything
other than figures, arithmetic operators and any currency symbols.
Example: 12 + 24 * 2
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2. Press Ctrl+plus sign, or choose Tools - Calculation.
The calculation result will be stored on the clipboard.

3. Place the cursor at the point where you want to insert the result of the calcula-
tion and press Ctrl+V, or choose Edit - Insert.

In the example, 60 is inserted. If the formula is still selected at the time of inser-
tion, the result replaces the formula.

Performing Calculations With Tables in Text
Documents

You can carry out calculations in StarOffice Writer tables. With calculations that go
beyond the current table, the table name serves as a clear table identifier.

To multiply the first cell of Tablel by the first cell of Table2 and return the result in
cell A2 in the current table, position the cursor in cell A2 in the current table, press

=<Tablel.Al> * <Table2.Al>

With the help of the Navigation Bar you can navigate quickly and easily between
the table formulas in your document.

If a table formula refers to an invalid table cell, a "**Faulty expression**" is
displayed in the cell. Invalid table cells are either deleted cells or those which are
themselves faulty.

To add cells B1:B10 from Tablel and see the result in the single-cell Table2 (which
should be somewhere in your text), do the following:

1. Create the text and Tablel. Write the text where you want the result to appear.

2. Now insert a frame (Insert - Frame menu command). In the Frame dialog select
the character to be used as an anchor, and deselect the border.

3. You can deselect the frame by clicking outside it; when you want to enter text
in the frame, click in the very center of the frame. The frame should not be
selected, but the text cursor should be inside the frame.

4. Insert the single-cell table inside the frame (Insert - Table). Select a row and a
column and click OK. The cursor is positioned in Table2.
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Define the mathematical formula by entering an equal sign. You can see the
Calculation Bar.

Select the cells in Tablel in which the "summand" formula is positioned; keep
the button pressed as you drag the mouse from the first to the last cell you
want. The formula for calculating the total of cells B1 to B10 is:
=<Tablel.B1:B10>

Close the mathematical formula by clicking the Accept icon on the Calculation
Bar. You will see the result of the calculation in Table2.

After making changes to the "summands", you can update the result by
pressing function key (F9).

Instead of first inserting the border and then inserting a table inside the border,
you can start by inserting a single-cell table, then select the whole of this cell -
the only way to do this is with the shortcut keys (Ctrl)(A) - and then click on
the Insert - Frame icon. The border automatically surrounds the table (inciden-
tally, this also works with any section of text). Now you can set the anchor to
character, cut the whole table to the clipboard and paste it where you want,
remove the borders from the frame and table and apply further settings.

Calculating Across Multiple Tables

In a text document, insert two tables each with several rows and columns.

Enter a few figures in the tables, but leave at least one cell empty.

The tables were automatically named "Tablel" and "Table2". You can give a table a
different name (Format - Table, Table tab, text box Name). Use only letters and
numbers in the name.

1.

2
3.
4

Position the cursor in an empty cell.

. Press (F2) to display the Formula bar.

As an example, enter SUM.

. Now you can click in both tables in the cells containing figures. After each click,

enter a plus sign (+) from the keyboard, then click on the next cell containing a
figure.

Finally, click the Apply icon on the Formula Bar. If, for example, you want to
add up the first two rows of each table and show the total in Table2, the
formula is =sum<Tablel. A1>+<Al>.
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Calculating Cell Totals in Tables

1.
2.

Insert a table with multiple rows (Insert - Table) into a new text document.

Enter a series of numbers into a column, one number per row, leaving the last
cell of the column empty.

Position the cursor in the last empty cell of the column, and click the Sum icon
in the Table object bar.

The Formula bar appears, and a formula indicates the cells of the column to be
added. The cells are separated by a vertical slash (I).

Press the Enter key to confirm, or click Apply in the Formula bar. The sum will
appear in the last cell.

If you change the numbers in the table, the sum will automatically be updated. If,
for example, you want to format the numbers as currency, select the cells and
choose Number Format from the context menu. The Number Format dialog
appears, where you can choose a new format.

Merging and Splitting Cells

You can select adjacent cells together, then merge them into a single cell.
Conversely, you can take a large cell that has been created by merging single cells,
and divide it back into individual cells.

The commands are different in StarOffice Writer and Calc.

Merging Cells in StarOffice Writer

1.
2.

Select the adjacent cells.

Choose Format - Cell - Merge.

Splitting Cells in StarOffice Writer

1.
2.

Place the cursor in the cell to be split.

Choose Format - Cell - Split.
A dialog allows you to split the cell into two or more cells, horizontally or verti-
cally.
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Merging Cells in StarOffice Calc
1. Select the adjacent cells.

2. Choose Format - Merge Cells - Define.

Canceling the merging of cells in StarOffice Calc
1. Place the cursor in the cell to be split.

2. Choose Format - Merge Cells - Remove.

Inserting or Deleting Rows/Columns Using the
Keyboard

This is how to insert and delete rows and columns using the keyboard:

= To insert a new column or row, first of all switch the table to the insert mode
for tables by pressing (Alt)(Ins). This lasts for three seconds. During these three
seconds, press the relevant arrow key to insert a new row or column to the
right or left, above or below the current row or column. If you hold down the
(Ctrl) key as well as the arrow key, the adjacent cell will be split.

= To delete a column or row, first of all switch the table to the delete mode for tables
by pressing (Alt)(Del). This lasts for three seconds. During these three seconds,
press the relevant cursor key to delete a row or column to the right or left, above or
below the current row or column. If you hold down the (Ctrl) key as well as the
arrow key, the current cell will be merged with the adjacent cell into one cell.

Repeating Several Heading Rows in Tables

Within a table, if you want to automatically repeat more than one row following a
page break, this is how to do it:

1. Select the first table row.
2. Open the context menu and choose Cell - Split.

3. In the Split Cells dialog, select the "horizontal" direction. Enter the number of
rows that are to be repeated and confirm your choice with "Ok".

All rows at the beginning of the table created in this way will now be repeated
after a page break.
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Enlarging and Reducing Cells in Text Tables

You can change the width and height of rows and columns using the keyboard, by
dragging and dropping with the mouse or by commands in the context menu. You
can also change the column width numerically via a dialog.

= You can also distribute rows and columns evenly with the icons on the
Optimize floating toolbar on the Table Object Bar.

With the mouse, you can modify rows and columns either in the table directly, or
with the aid of the rulers. If you rest the mouse on a vertical dividing line in the table,
the pointer appears as a separator symbol, and you can simply drag the dividing line
to the desired position. (You may need to click once outside the table before this
procedure will work.) You can move the dividing lines on the ruler in the same way.

When you enlarge and reduce using the keyboard, you must always hold down
the (Alt) key. If you also press one of the four arrow keys, the current column or
row will be enlarged or reduced by an amount that you can set under Tools -
Options - Text Document - Table under Keyboard handling, with rows and
columns being handled separately.

The current row or column is enlarged or reduced at its right-hand or lower edge.
If you press the Shift key as well as (Alt), the left-hand or upper edge will be
moved. Here are two examples:

= Position the cursor in the middle of a medium to large text table.

» Hold down the (Alt) key, and press the right arrow key. The current column
will be expanded by the amount specified in the tab Table under Tools -
Options - Text Document. The left edge of the column remains fixed while the
right edge moves.

= Now, hold down the (Alt) key together with the Shift key and press the right
arrow key. The right edge remains fixed and the left edge moves to the right,
thus reducing the column.

You can adjust the height of the rows in the same way. However, since the rows
are preset to a minimum height, you must first enlarge them before you can see
the result.

If you also press the (Ctrl) key during the process, the enlargement or reduction
applies only to the active cell instead of to the entire row or column. The propor-
tions of the table remain fixed.
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Adapting Table Widths

The display attributes of a table are defined by the settings under Tools - Options
- Text Documents - Tables. You can also click the icons in the Table object bar to
switch between the attributes Fixed, Fixed /Proportional, and Variable.

Table Mode Fixed means, for example, that if you make one cell wider the
adjacent cell will become narrower. Other cells will not be affected, and the
overall width of the table stays the same.

Table Mode Fixed and Proportional means that all adjacent cells become
proportionally narrower. In other words, wide cells will shrink more than
narrow ones. Again, table width remains constant.

Table Mode Variable means that the width of the entire table is variable.
Whenever an individual cell is made wider, the entire width of the table
expands as well.

When you insert or delete (cells, rows or columns), the table mode decides how
the neighboring cells, rows or columns should behave. In the table mode, new
rows and columns are only inserted in a fixed way if there is sufficient space.

Copying Sheet Areas to Text Documents

1.
2.
3.

Open both the text document and the spreadsheet.
Select the sheet area you want to copy.

Point to the selected area and press the mouse button. Keep the mouse button
pressed for a moment, then drag the area into the text document.

If the documents are not visible next to each other, first drag the mouse pointer
to the destination document button. Continue to hold down the mouse button.
The document addressed in this way is displayed, and you can move the
mouse pointer within the document.

Once the cursor is located in the place where you want to insert the sheet area,
release the mouse button. The sheet area is inserted as an OLE object.

You can select and edit the OLE object at any time.
To edit the OLE object, simply double-click on it.

Alternatively, select the object and choose Edit - Object - Edit or choose Edit from
the context menu. You edit the object in its own frame within the text document,
but you see the icons and menu commands needed for spreadsheets.

Choose Open to open the source document of the OLE object.
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Images, Drawings, Clipart and
FontWork

You can insert images, graphics, drawings and clipart in your text document, or
you can distort text with FontWork.

Positioning Objects
There are various ways of anchoring the objects on a text page, such as graphics

and text frames. We will describe the various options, based on the example of a
frame:

Anchoring Effect

as a Character Frames are placed in the document like any other character,
hence, they have an impact on the line size of the line and the
line break.

to Character Frame is with its X and Y coordinates associated to a character,
for example, in the X direction always to the margin and in the Y
direction always to the height of the character (marginal frame).
The frame should be set at "Flow".

to Paragraph ~ Frame is associated to a paragraph, changes its position with the

paragraph.

on the Page Frame has always the same position in relation to the page
margins.

on Frame Frame is inside the superior frame in a fixed position.

The position in relation to the anchor can be chosen through various possibilities.
For example, it is possible to set the frame on a fixed position in relation to a page
margin, to a paragraph margin, to a text area, etc.

The frame position on even pages can be automatically mirrored, so that a fixed
position in relation to the right side of the page produces a corresponding position
on the left side of the page. For example, you can position a graphic always inside
the outer edge of pages. Where the graphic is, say, an arrow pointing to the text, it
is a good idea to mirror this automatically on even pages too. To do this, use the
Mirror on even pages option on the Type tab of the Graphics dialog (choose
Format - Graphics).
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Captions and Number Ranges

In text documents you can create separate, continuously numbered captions for
figures, tables and drawing objects.

You can also define as many separate number ranges as you like.

The captions are linked to the figures, tables or drawing objects in a frame. Select
the frame when you move the object.

Defining Captions

1. Select the figure or the object or place the cursor in the table for which you
want to insert a caption.

2. Open the Caption dialog with the command Insert - Caption.

3. The dialog shows you a preview of how the caption will look. You can add
further text in the Caption field. Click OK.

If you would like to place a tab stop between the automatic captions (e.g., "Figure
1") and the additional text, you can insert it in the document later. Press Ctrl+Tab
to insert a tab stop at the beginning of a paragraph.

1

The paragraph format of the automatically applied caption is obtained from the
Paragraph Style "Illustration”, "Table", "Drawing" or "Text". All of these Paragraph
Styles are derived from the "Caption" Paragraph Style. So if you want all captions
always to appear in green, for example, simply modify the "Caption" Paragraph
Style accordingly in the Stylist. Switch the Stylist to the "All Styles" view or to the
hierarchical view.

Editing or deleting captions

A caption is normal text which is placed together with an object in a common
frame.

= Edit the caption text just like normal text.

= Delete the caption text just like normal text.
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Inserting an object in a number range

Suppose your document contains illustrations as linked graphics, and these are
labeled in a number range called "[llustration". Now you want to add a drawing
obtained with the drawing tools as a further illustration. Extend the automatic
number range "[llustration" as follows:

1. Below the additional illustration, insert a new line and apply the Paragraph
Style "[llustration.”

2. Start the Fields dialog, by pressing (Ctrl)(F2) for example.

3. On the Variables tab select the Type "Number range". Under Selection select
"Tlustration".

4. Click Insert and close the dialog box.

If you move illustrations with your captions by hand so that the sequence changes,
it may be necessary to update the numbers by pressing F9.

Numbering Illustrations by Chapters

To number illustrations by chapter, so that illustrations are labeled "Illustration
1.1", "Tllustration 1.2", etc. in the first chapter and "lllustration 2.1", "Illustration
2.2", etc. in the second, proceed as follows.

1. Organize your document by chapters if you have not already done so. Choose
Tools - Outline Numbering to number the chapter headings that you have
formatted, for example, with the Paragraph Style "Heading 1". Select the
"Heading 1" Style from the Paragraph Style list box and the option "1, 2, 3,.."
from the Number list box below it.

2. Select the first illustration you want to number.
3. Choose Insert - Caption....

4. In the dialog that appears, select Illustration as the category and Arabic (12 3)
as the numbering. You also can enter your caption text in this dialog.

5. Click Options. Specify the chapter numbering in the Number Range Options
dialog. For this example, select option "1" under Level and specify the separator
you want for chapter-wise numbering. Click OK.
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6. In the Caption dialog, click OK. Your illustrations are now numbered by chap-
ters.

Do the same for all other illustrations in your document.

The numbering occurs automatically: All illustrations within one chapter level are
numbered, and you can enter at which chapter level you want the numbering to
switch in the Number Range Options dialog.

Choose Tools - Options - Text Document - General, and under Caption mark
the Automatic check box. When you click the button next to Object selection, the
Caption dialog appears. This is where you can, for example, determine that from
now on all illustrations in text documents receive a caption automatically.

ﬁu‘}
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Inserting Graphics

There are several ways of inserting a graphic object in a text document.

Inserting Graphics via Dialog

1. Place the cursor at the position in the document where you want to insert the
graphic.

2. Choose Insert - Graphics - From File. You will see a dialog Insert Graphics.
3. Select the desired graphic and click on Open.

By default, the graphic is inserted so that it is centered above the current paragraph.

Inserting Graphics From StarOffice Draw or Impress

You can copy a graphic object from one document to another by drag and drop. If
you plan to publish your document, please observe copyright laws and be sure to
obtain the consent of the authors of the original page.

1. Open the document in which you want to insert the graphic object.
2. Open the document from which you want to copy the graphic object.

3. While pressing the Alt key, click the graphic object. This selects the object
without activating a hyperlink that may be connected to it.

4. Keep the mouse button pressed and wait a moment while the object is copied to
the clipboard.

5. Drag the graphic object into the other document. If the documents are not
visible side by side, first move the mouse pointer to the button of the target
document. Keep the mouse button pressed! The document in question is then
displayed and you can move the mouse pointer into the document.

6. Release the mouse button as soon as the gray text cursor indicates the position
where you want to insert a copy of the graphic object.

7. If the object is connected to a hyperlink, the hyperlink will be inserted instead
of the graphic object.
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Inserting Graphics via Drag and Drop From the Gallery

Drag and drop a graphic object from the gallery into a text document, spreadsheet
or presentation to insert the graphic object.

When you release a graphic object directly on a drawing object, the following
rules apply:

=  When dragging without pressing a key (i.e. you do not see another sign next to
the mouse pointer) only the drawing attributes are transferred from the Gallery
and applied to the drawing object over which you release the mouse button.

=  When dragging while pressing the Ctrl key(i.e. you see a plus sign next to the
mouse pointer) the graphic object is inserted as an object.

=  When dragging while pressing the Shift and Ctrl keys (i.e. you see a linking
arrow next to the mouse pointer) the drawing object will be replaced by the
object from the Gallery. The position and size of the object that was replaced
will remain valid for the new graphic.

Inserting Graphics With a Scanner

To carry out scanning in StarOffice, you must have installed a scanner with appro-
priate driver software on your system.

Under Windows, StarOffice supports the TWAIN standard. Under Unix,
StarOffice supports the SANE standard.

1. Place the cursor at the position in the document where you want to insert the
graphic.

2. Choose Insert - Graphics - Scan.

The submenu contains a command to open a dialog for selecting the scanning
source.

3. From the submenu, select the command to request scanning.

The scanner driver opens a window in which you should follow the scanner
manufacturer's instructions. Once the scanning process is completed, the image
is inserted in your StarOffice document.
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Inserting a Chart From StarOffice Calc

Dragging and Dropping a Copy of the Chart

1.
2.
3.

Open the StarOffice Writer document in which the chart is to be inserted.
Open the StarOffice Calc document containing the chart.
Select the chart with a single click. Eight handles will appear around the chart.

If you accidentally double-click the chart, it will be put in the edit mode, indi-
cated by a gray border. To exit the edit mode, single-click outside the chart.

Drag the chart into the StarOffice Writer document.

If the StarOffice Writer document is not visible, you can first arrange the
windows appropriately. If your operating system or windows manager
provides a task bar, you can drag the chart to the StarOffice Writer button on
the task bar, hold that position for a moment while the StarOffice Writer
window opens in the foreground and then drop it in the now visible document.

In the StarOffice Writer document, position the chart or modify the scale as you
would any object. To later modify the chart data, double-click and edit it.

Charts with Linked Data

If the data in the StarOffice Calc document changes, the chart inserted by this
method will not automatically be updated. To always have the data up-to-date,
you can do as follows:

1.
2.

In the Calc document, copy the cell range from which the chart is created.

Go to the Writer document, long-click the Insert icon to open the submenu,
then select DDE Link.

The data is now in a table in the Writer document and is always linked via DDE
to the source data in the Calc document.

Position the cursor in the table. Long-click the Insert Objects icon on the main
toolbar to open the floating toolbar where you then click the Insert Chart icon.
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Inserting Decorative Horizontal Lines

Choose Insert - Horizontal Line to open a dialog for selecting decorative lines.

Inzert Horizontal Ruler x|

Selection | I

The lines are graphics anchored to the current paragraph and centered between
the margins.

You can also find these lines in a Gallery theme. If you want to continue using a
line from the Internet, add it to the relevant theme in the Gallery. The line can then
be selected from this dialog.
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Headers, Footers and Footnotes

Add headers and footers to your pages of text. Insert footnotes or endnotes.

Remarks Concerning Headers and Footers

Headers and footers are always linked to the Page Style. All pages with the same
Page Style automatically have the same headers and footers. By using Fields in the
headers and footers you can insert variable content in your text documents, such
as page numbers and chapter headings.

» If you want to have other differences in the content of headers and footers, it is
best to create different Page Styles and apply these to the pages.

» Choose Insert - Header or Insert - Footer to select the Page Style in which you
want to insert or remove headers or footers.

» You can also choose Format - Page to start a dialog that allows you to select
headers or footers for the current Page Style. Here you will find a check box
Same content left/right. If this is not marked, you can format different headers
and footers on the left sides than on the right sides.

If you only want to assign a single page a different header, you could also insert a
text box to cover the header text. Anchor the frame to the page, and assign the
"Wrap Through" option and the background color "White."

Remarks concerning headers and footers in HTML format

Some of the header and footer commands are also available for HTML docu-
ments. Since these headers and footers are not provided in the HTML definition,
they are exported as special tags and are correctly interpreted again upon loading
an HTML page with StarOffice. Web browsers show the content of the header or
footer as the text which was there at the time of the HTML export, whereas
StarOffice inserts a field again and updates this as and when necessary.
(However, author and sender are only inserted as a field if you yourself are the
author or were the last one to modify the document.) Headers and footers are
exported in HTML documents if they are enabled in Online Layout mode.
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Inserting Page Numbers in Footers

1. Insert a footer. Choose Insert - Footer and select from the submenu the Page
Style you would like for the footer. The cursor now appears in the footer.

2. Choose Insert - Fields - Page Numbers. The page number appears as a field in
the footer.

3. Select the page number and click on the Centered icon on the object bar.

If you would like the footer text to be in the form "Page 9 of 12", you should also
do as follows:

1. Type the word "Page " before the field and " of " after the field.

2. Choose Insert - Fields - Page Count.

Inserting Chapter Information in Headers

In the document header you can insert fields that contain the file name, date, time,
chapter headings, etc.

1. Enter text in a long document and apply the style "Heading 1" to chapter head-
ings.

2. Activate the header for the document (Format - Page - Header or Insert -
Header).

3. Click within the header to position your cursor in it.
4. Enter "Chapter: "

5. Choose the command Insert - Fields - Other .
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Fields
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Type Select: Format
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Date Chapter number and name
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Page
Sender
Statistics
Templates
Time
il | 2]
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I =
Insert I LClose | Help |

6. In the Fields dialog, select the Document tab, type Chapter, format Chapter
name. If you want the header to contain paragraphs formatted with Heading 2
instead of Heading 1, enter a 2 under Layer.

7. Click Insert to add the desired information to the header, and then close the
dialog box.

Now every page of your document will automatically display the chapter heading
of your choice in the header.

Other information can be inserted in the same manner. You'll find further menu
commands under Insert - Fields. You can choose from Date, Time, Page
Numbers, Page Count, Subject, Title and Author. All additional field commands
can be selected under Other.
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Defining Different Headers

A defined header and footer appear in all pages that have the same Page Style.
However, you may often need a different header for the first page or for even and
odd-numbered pages. For example, you may want the name of the chapter to
appear on the left (even) pages and the name of the first subchapter to appear on
the right (odd) pages. Since headers are a property of the Page Styles, you need to
define two different Page Styles and apply them to the respective pages. There are
preset Styles for First page, Left page and Right page, which you can adapt to
your specific needs.

For example, the Page Style for left pages might have different inner and outer
margins, and the style for right pages would be a mirror image of those margins. If
you don't need different headers and footers, simply choose a mirrored page
layout (under Page Layout in the tab Page).

Switching between odd and even Page Styles and between First Page and Left
Pages can be done automatically by defining the Next Style. If you define the Page
Style with Next Style and apply the new Page Style to the first page, then
StarOffice will automatically apply the correct Page Styles to the continuation

pages.
1. Open a new text document.

. Click the Page Styles icon in the Stylist.

. Select the Style First Page to use as the basis for your own Page Style.

2
3
4. Open the context menu and choose New.
5

. In the Page Styles dialog, go to the tab Organizer. Give your Page Style a
name, such as "Pagel," and define "Left Page" as the Next Style.

6. For the "Left Page" define "Right Page" as the Next Style, and for the "Right
Page," choose "Left Page."
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Inserting Page Numbers of Continuation Pages

With Insert - Footer, insert a footer. Set your cursor in the footer and in your main
menu go to Insert - Fields - Other.... Select the Document tab. Under "Type" select
"Page", under "Select" select "Next page" and under "Format", select "As Page
Style". Finally click Fields to insert the field command in the footer of your
current document.

In your document you'll have displayed the page number of the next page, with
the exception of the last page.

If the word "page" should also appear in front of the page number, insert another
field of the same type but with another format: Set the cursor in front of the field
that you just inserted in the document and call the Fields dialog. Again, select a
field of the "Page" type, under Select, select "Next page" and under "Format",
select "Text". In the Value text box, enter the text to be displayed if a next page
exists in the document. Enter "Continue on page " (note the space at the end!) and
click Insert.

Of course, you can also enter instead of "Continue on page ", something else. For
example, ".../", to indicate the number of the next page.

Inserting Lines Under Headers

You can adjust the appearance of the header directly in the header itself. If you
click on an existing header, you can then format the text individually or as a whole
paragraph. Additional attributes are available in the Format - Page dialog in the
tab Header.

You can also select the Header tab to define a document header for the first time.
Mark Header on. When you close the dialog by clicking on OK, a header is created
which you can then fill out in the document.

« If you click the More button on the Header tab, you can choose additional
settings for the border and background of a header.
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= Draw a line under the header by going to the Borders tab. Under Line arrange-
ment click between the two lower angle marks at the bottom of the rectangle.

You can also use this tab page to define the style of the line and the distance
between the header text and the line.

Footnotes and Endnotes

You can display footnotes in a text document at the bottom of a page (or column if
you are using more than one column) or at the end of a document. The settings are
defined by choosing Tools - Footnotes.

The following information is also valid for endnotes. Endnotes are footnotes that
appear collectively at the end of a document instead of at the foot of each page.
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You can jump from a footnote anchor in the document to the footnote text quite
easily by clicking on the footnote anchor. Press PgUp to return from the footnote to
the text.

= The footnote format can be changed by modifying the Paragraph Style "Foot-
note," which is automatically applied to all footnotes in a document.

= To delete a footnote, simply delete the footnote mark in the text. The footnote
text will automatically be deleted as well.
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Inserting and Editing Footnotes

You can insert a footnote in two ways: with an icon or with a dialog.

This is how to insert a footnote with an icon

1. Place the cursor in the text at the point where the footnote anchor should

appear.
2. g Open the Insert floating toolbar on the main toolbar.

3. =g Click on the Insert Footnote Directly icon.

This is how to insert a footnote with a dialog

1. Place the cursor in the text at the point where the footnote anchor should
appear.
2. Choose Insert - Footnote to open the Insert Footnote dialog.

When you insert a footnote with the icon, footnote numbering is automatic. The
Insert Footnote dialog on the other hand allows individual settings for the footnote.

Tips for Working with Footnotes
= To edit the text of a footnote, click in it and then you can modify it.
= Press (PgUp) to jump from the footnote area to the footnote anchor in the text.

» To edit the properties of a previously inserted footnote, place the cursor in the
document immediately before the footnote character and choose Edit - Foot-
note or double-click immediately before the footnote character.

= To define general settings applied automatically to footnotes in the document,
choose Tools - Footnotes to open the Footnote Settings dialog.

=  You can format footnotes with Page Setup by choosing Format - Page... - Foot-
note.

In multicolumn pages, the footnote is inserted in the column where the footnote
anchor is situated.

You can also use the mouse to jump from the footnote anchor to the foot-
note. The mouse pointer changes its appearance as soon as it is over the
footnote anchor.
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Spacing Between Footnotes

If you want a bigger distance between the different footnotes or endnotes, you can
add an invisible (white) line as the lower border to the corresponding paragraph
format:

1.

AR

*

Place the cursor in a footnote.

Open the Stylist.

Click on the Paragraph Style to be modified (footnote).
Open the context menu and select Modify.

On the Borders tab page, select a top and a bottom line and give them both the
color white.

In the Spacing to contents area, unmark the Synchronize check box.
Increase the value of the upper or lower spacing.

Click OK.
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Spellcheck, Dictionaries, Hyphenation

Controlling the Spellcheck via Dialog

Often a little trick is necessary in order to open the Spellcheck dialogs. If you
choose Tools - Spellcheck - Check or press F7, but there are no unknown words in
your document, you will not see the dialog. In this case, you need to enter a delib-
erately misspelled or unknown word.

Spellcheck [Englizh [USA]) B

Original sratement lgnore

atement Q = Ignore Al |
-

Suggestions
Always Replace |

AtoEorrect |

Thesaurus.. |
Language I"'icf English (U54) j Options... |
Dictionary Isoffice [Adl] j Add | - Backwwards

Unkrcws wotd. Help | Close |

Wiord

You will see the Spellcheck dialog when you call the spellchecker manually via
the menu or by pressing F7. This method has the advantage that, before calling the
dialog, you can select text and then check the spelling only in the text you have
selected. The Spellcheck dialog is described in detail in the StarOffice Help.

A manually initiated spellcheck always begins at the cursor position, unless the
text was selected (in which case it begins at the beginning of the selected text and
ends at its end). If the spellcheck does not begin at the beginning of the document,
and if the end of the document is reached during the checking process, a dialog
appears asking whether you want to continue checking at the beginning of the
document.

The system always searches first through the selected user-defined dictionaries. If
the word is not found there, it searches through the main dictionary. If the word is
not there either, you will see the dialog illustrated, which allows you to replace the
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word. Type it correctly in the Word field or select a word from the list of Sugges-
tions, and click on Replace.

The word in the Word text box can be permanently added to the user-defined
dictionary. First, select the Dictionary combo box. Then, click Add.

RES When you replace the word in the Word field with another word, you can
check this other word by clicking on the Check Word button.

If you want, you can automatically enter all unknown words in a text in the active
user-defined dictionary. For instructions, refer to StarOffice Help.

Automatic Spellcheck

» From within a text document, click the AutoSpellcheck on/off icon on the main
toolbar. All words marked as incorrect by the spellchecker will then be under-
lined in red.

» Click on words underlined in this way with the right mouse button. A context
menu then appears.

= The context menu often provides a list of suggested words, one of which you
may click on to select it. The suggested word then replaces the word under-
lined in red.

If you replace the wrongly typed word using the AutoCorrect function in the
context menu, the word pair will be entered in the AutoCorrect replacement table.
To call up this table, choose Tools - AutoCorrect/AutoFormat - Replace tab.

If the word underlined in red is correct, you can place it in your custom dictionary
using the Add command.

To exclude words from the spellcheck:
1. Select the words.

Open the context menu of one of the words.
Choose Character.

Choose Format - Character - Font tab.

SARE- R A

Now select the language [Nonel].
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Removing Words From User-Defined Dictionaries

1. Choose Tools - Options - Language Settings - Writing Aids tab.
2. Select the user-defined dictionary and click Edit.

3. Now you will see the Edit User-Defined Dictionary dialog, in which you can
search through an alphabetic list.

4. Select the word and click on Delete.

Hyphenation
You can carry out hyphenation in text documents either automatically or manually.

= Automatic hyphenation is an attribute of paragraphs and Paragraph Styles.
This means that you can switch the hyphenation on or off for a paragraph or for
a paragraph format and select its properties.

= Manual hyphenation gives you individual control, but is time-consuming.

Automatic hyphenation
Automatic hyphenation is turned off by default.

1. If you want to switch on hyphenation for one or more selected paragraphs,
open the context menu and select paragraph.

If you want to switch on hyphenation for all paragraphs formatted with a
certain Paragraph Style, open the context menu in one of the paragraphs and
select Edit Paragraph Style.

To use hyphenation in all paragraphs, edit the Default Paragraph Style from
which the other Paragraph Styles are derived.

2. In the next dialog, click on the Text Flow tab.

3. Under Hyphenation, mark Automatically.
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Manual Hyphenation

» For manual hyphenation, place the cursor at the point where the word should
be separated and press (Ctrl)(-).

The word will be separated if it is possible, even if automatic hyphenation is
turned off for the paragraph.

If you have entered a hyphen directly, StarOffice will not apply the automatic
hyphenation for that word. Let's assume the word "Antarctica” would be hyphen-
ated: An-tarcti-ca, but you want it: Ant-arc-ti-ca. Enter all three hyphens manually

(directly), including the one between "i" and "ca" that is the same as in the auto-
matic hyphenation.

There is a quick way to prevent a particular word from being affected by the
hyphenation (or spellcheck) functionality:

= Select the word and choose Format - Character. On the Font tab select
Language None.

If you want to permanently prevent a word from being automatically hyphen-
ated, so that it will never be separated, place it in an active user-defined
dictionary with an equals sign after it:

1. Choose Tools - Options - Language Settings - Writing Aids
2. Select a User-defined dictionary and click the Edit button.

If you do not yet have a user-defined dictionary, you can create one by
clicking the New button.

3. In the next dialog Edit Custom Dictionary enter the word, for example,
"Companyname="(without quotation marks) and close the dialog with Close
and OK.

Now, the word "Companyname" will never be hyphenated.

You do not have to search through the text yourself to find words to hyphenate
manually. Choose Tools - Hyphenation. This starts a dialog showing, one after the
other, all words that could be hyphenated with the current line break.
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The place at which the word could best be hyphenated with the current line break
is highlighted. Click on the left arrow button to move the highlighting to the left if
you would like the word to be hyphenated at an earlier place. As soon as you click
on Hyphenate, the word will be hyphenated at the highlighted place. Then you
will see the next word that could be hyphenated.

If the spellcheck recognizes the word, the hyphens entered there will be displayed
as well.

Thesaurus

You can use the thesaurus to look up related words.

Thesauruz [English [USA])) x|
Wariations

aK I
Replace
: |clean p— |
Meaning w0y Search |
To make ar keep fan area) clean andgg| lear Language.. |
police

To make or become clear by the re
Free from evil and corruption tidy

Free from dirt, stain, or impurities - [straighten Help |
3 I

et loisd qv abhercns SPrUCe

1. Within your text, select the word you want to look up in the thesaurus.
2. Choose Tools - Thesaurus or press (Ctrl)(F7).

In the dialog which then appears, you can scroll down the two lower list boxes
until you find a suitable word. If you close the dialog by clicking on OK, the
selected word will be replaced by the word in the Replace field.
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o-*

The thesaurus is not available in all languages for which a spellcheck has been
installed.

If you are looking for alternatives for a word in another language for which a
thesaurus is installed, for example an English word, select the word in the text and
call up the thesaurus. Click on the Language button to switch to "English (UK)" or
"English (US)", in order to select British or North American style. Then click on
Search.
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Help |
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i =
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If you applied English language attributes to the English words in your text
(Format - Character, Font tab, Language list box), then the spellcheck, thesaurus
and hyphenation will automatically be in this language. You can assign a language
to Paragraph Styles in the same way.
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Form Letters, Business Cards and Labels

Write form letters, design business cards and produce labels - all from data
obtained from a data source or that is sequentially numbered.

Creating Form Letters

To aid you in creating form letters, the following section first gives you brief
instructions and then detailed instructions.

Brief Instructions (For Quick Results)
1. Register an address data source in StarOffice, if you have not done so already.

You can find instructions under the search term "address book" in the
StarOffice Help.

2. Press Shift+Ctrl+N to open one of the form letter templates provided.

In the Business Correspondence category, select the Elegant Letter, for
example.

3. Select the addresses to be used for the form letter, or enter them now.

4. Let StarOffice create the form letter and print it.

Detailed Instructions (With Background Information)

To create a form letter you need the recipients' addresses, which should be in the
form of a database table, and a text document containing the text of the letter. You
will notice that fields appear at the positions in the text where the name and
address should be printed. These fields draw their information from the corre-
sponding database fields. You can define these fields if you go to the Insert menu
and choose Field and from the sub menu select Other. The Fields dialog will
appear, where you can define the fields.

Fields are a type of place holder in your document. These can be chosen when
first inserting a field or opening or printing a current document. You can carry out
an update manually with the (F9) key.

174 StarOffice 6.0 User's Guide * March 2002



Fixed and Variable Fields

"Fixed" fields are fields which are filled out only once, i.e., when the field is
inserted into the document. For example, if you write an invoice based on an
invoice template you can use a "fixed" date. The minute you set up the invoice
document, you will see in the field position the actual date which will not change
later on. That is, the date of the invoice is determined only once.

Fields B3
I]m:umentl Feferences I Functions | Doclnformation I “ariables | Databaze |

Type Select Format

ALIThor

Chapter Date

Dec 31, 52

File riame Dec 31, 15589

Page =1. Dec. 1939

Sender Decernber 31, 1999

Statistics 51. December 1999

Templates Fri, Dec 31,99

Time Fri 31/Dec 99
Fri, December 31, 1999
Friday, December 31, 1999
12-31 s
99-12-31
1995-12-31
12/99
Dec 31 =l
Offset in days
g =

Insett I LCloze | Help |

On the other hand, a "variable" date is updated every time you open and print the
document. A manual update of the fields (i.e. with the F9 key) sets the actual date
in the field entered as "Variable date"

If, for example, you want to insert a date as a field in your form letter, you have to
decide if it is to be inserted as a fixed or as variable date:

= Choose to use a fixed date if the date should never change, i.e., as if you could
have typed in the date directly (without a field). What is then the advantage of
using a field? You can save the form letter as a template, and if you later want
to write a new form letter based on that template, the date will automatically be
updated.

= If you choose the variable date, the date will be updated every time you open
or print the document.
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Apart from the date there are various other fields which you can also use in your
form letter. The most important fields are the ones which determine where the
different elements of the recipient's address are to be placed. These fields have a
direct connection to the database table which contains your address list. A field
will be inserted in the form letter for each data field (i.e. name, street, city, etc.).
When printing, StarOffice Writer inserts the desired data fields in the fields for
each record.

r If you want to create a completely new document containing the necessary form
letter fields, you can use drag and drop to do so: Open the text document and
press F4 to show the desired database table. Point to a column header and,
holding down the mouse button, drag it into the document. The field for
inserting this item from this database table is automatically placed in the docu-
ment.

ilu'}

= Choose File - New - Templates and Documents to open a document based on
the Elegant Letter template from the Business Correspondence category.

A form letter based on the "Elegant Letter" template will be displayed. It already
contains fields for the address, date, sender, etc.

= In the Use of this Template dialog that automatically appears, select the option
Several recipients (address database).

= Since the "Elegant Letter" template is linked to an address database, the address
table is opened automatically in the data source view. If this does not happen,
press F4 to open the data source for the current document.

= Select the records you want to use in the form letter by clicking the row headers
at the left in the data source view. Press the Shift key and/or the Ctrl key to
make your selection. To print a form letter for all the records in the table, click
the empty field above the row headers to select all records.

=1 Now click the Form Letter icon on the database bar at the top of the data
source view. The Form Letter dialog appears, where you can choose what
you want to send as e-mail or print. You can also choose if you want to
print selected records, all records or a particular range. If you want to print
arange, e.g., records 1 to 5, make sure that the numbers follow the order
displayed in the data source view.
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$4 You can sort or filter records in the data source view by clicking the respec-
tive icons on the database bar. For example, to sort all records according to
ZIP (postal) code, place the cursor in the ZIP CODE field of any record and
click Sort Ascending.

Now your form letter is all ready to go!

Avoiding Blank Paragraphs

If you have chosen the form letter field COMPANY to appear in the recipient
field, a blank line might appear in your printed letter. That happens if the
COMPANY database field in the database is empty. However, it is possible to
prevent empty fields from being included.

Place the cursor in your text document before the form letter field COMPANY.
Choose Insert - Fields - Other to open the Fields dialog. On the Functions tab
select the type Hidden Paragraph.

Now, in the Condition field, enter the following text (without quotation marks):
not (Company)

If the COMPANY database field is now empty, the COMPANY line will not be
printed, and the rest of the lines will be moved upward.
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Creating and Printing Labels and Business Cards

Designing Business Cards via Dialog

Choose File - New - Business Cards to open a dialog with several tabs which
allow you to choose how your business cards will look.

Designing Labels and Business Cards

There is yet another way of designing business cards - if you regard business
cards as a simplified, special kind of label. In general, all business cards are the
same. Labels can be filled with different contents obtained from a database, or they
can be marked with serial numbers.

1. Choose File - New - Labels to open the Labels dialog.

2. On the Labels tab, under Format, define the label format.

StarOffice Writer contains many formats of commercially available sheets for
labels, badges, business cards etc. You can add other, user-defined formats.

3. On the Labels tab, under Inscription, you can choose what you want written
on the labels.

This often involves database fields, so that the labels can be printed with
varying content, when sending "Form Letters" for example. But it is equally
possible to have the same text printed on every label.

Use the combo boxes to select the database and table from which the data fields
are obtained. Click on the big arrow to transfer the selected data field into the
inscription area. Press Enter to insert a line break. You can also enter spaces and
any other fixed text.

On the Format tab you can define your own label formats, not covered by the
predefined formats. To be able to do this, the label type on the Labels tab must
be set to "User-defined". On the Options tab, you can specify whether all labels
or only certain ones are to be created.

4. On the Options tab page, make sure that the Synchronize contents check box
is marked. If this is marked, an identically repeated label only has to be entered
(on the top left label) and edited once.

5. As soon as you click on New Document, you will see a small window with the
Synchronize Labels button. Enter the first label. When you click on the
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6.

7.

Synchronize Labels button, the current individual label is copied to all the
other labels on the sheet.

Click on New Document to create a new document with the settings you have
entered.

Print the new document.

Printing Labels With Serial Numbers

If, for example, you want to print lottery tickets or entry tickets with serial
numbers on them, this is how to do it:

1.
2.

3.
4.
5.

Choose File - New - Labels. This opens the Labels dialog.

On the Labels tab, under Format, select the format in which you want to print.
These label tags or rolls, available from specialist suppliers, are often made
from stiff paper with tear-off perforations, or they are self-adhesive labels on a
backing material.

If you want to define the format yourself, select the Format tab.
On the Options tab, mark Synchronize contents.

Click on New Document.

A new document is now created, divided up in the way you want. You only have
to edit the top left label, then press Synchronize labels to make all labels appear
the same. The button is only visible if you previously marked Synchronize
contents on the Options tab.
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7. Enter your text in the top left label and format the font the way you want it.
8. You can include serial numbering by inserting a field. Place the cursor at the
point where the number should appear. Press (Ctrl)(F2) or choose Insert -
Fields - Other.
9. In the Fields dialog, go to the Variables tab.
10. Select the type Set variable, if it is not already marked.
11. In the Name box, enter a name of your choice for the counting variable, for
example Number.
12. To increment the variable from one label to the next by 1, enter the following
formula in the Value text box: Number+1.
13. Click Insert, then close the Fields dialog.
14. Click Synchronize Labels.
15. Now you can save and print the finished document.
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Printing Address Labels

If you want to print address stickers, for form letters which do not fit in window
envelopes, for example, this is how to do it:

1.
2.

Choose File - New - Labels to open the Labels dialog.

Select the format of the label sheets you want to print on. Remember to mark
Synchronize contents on the Options tab. Click on New Document to close
the dialog.

When you see the label document, open the data source view by pressing the
F4 key. Click the thumb tack icon at the edge of the data source view if it
covers the first label.

In the data source view, select your address data source table.

Drag the data fields needed for the Address individually into the top left label.
For example, click on the column header NAME and, keeping the mouse
button depressed, drag it into the label. This inserts a field. Put the fields in
order to complete the address in the first label at top left.

Place the cursor at the last text position (after the last field) in the first label.

Open the Fields dialog, for example by pressing the shortcut keys (Ctrl)(F2),
and go to the Database tab.
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8. Select the type Next record, click on Insert and then on Close.

9. You can now synchronize the labels. Click on the Synchronize button in the

small window.

10. In the data source view, select the records for which you would like address
stickers, by clicking on the row headers to the left. Use the Shift or Ctrl key in
the usual way to select several records at the same time.

11. ,5; On the database bar, click the Data in Fields icon.

12. You can then save and/or print the label document.

f After the last label on the page, the command Next Record is effected automati-
L] cally. Therefore, do not insert the command manually after the last label on a
page.
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Newsletters

In this section, learn how to create a newsletter /newspaper as a text document.
This is useful for creating newsletters for your company or club, or in celebration

of a special event.
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Creating a Newsletter From a Template

In the File menu choose New - Templates and Documents. On the left, double-
click Miscellaneous. Double-click to open the Newspaper Template.

In a dialog you can now select the type of newspaper or newsletter you want to
create. Depending on the type, some variables will be differently predefined, e.g.
for the Headline.

The document contains several elements that you could make good use of in your
newsletter. It contains, for example, an automatic page numbering system and a
field with the fixed date.

You can now enter text and position graphic objects.
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Click the headline. This text is an input field. You can modify the existing heading
in a dialog.

A few other texts hightlighted in gray are variables, which you double-click to
modify.

After you have finished creating the document, you can save and print it.

However, if you would like to have a more personal and interesting layout, you
can edit the template a bit more.

Creating Page Styles

If you want to have a page which includes not only text but also several larger
graphics, you should create a separate Page Style for this purpose.

Open the Stylist and click the Page Styles icon. In the context menu, select
the command New to open the Page Styles dialog. In the tab Organize,
assign a descriptive Name for the Style.

Next, click the Page tab and define the page format and margins. Mark the check
box Register-true and choose the reference Paragraph Style Text Body.

# If you activate the register-true option, the baselines of all paragraphs with the
Text Body Style will be exactly aligned so that they are at the same position in

each column and on each page in relation to the page. With double-side printing,
the baselines of the register-true paragraph will have the same position. You will
normally take as a Paragraph Style the Style you used to create your actual text.
To define another Paragraph Style as register-true, call up the properties dialog
of that Paragraph Style. Call it up, for example, in the Stylist via the context menu
of that particular Paragraph Style, select the Modify command. On the Indents
and Spacing tab, in the field under Register-true, select Activate.

Editing Headers

To edit a header, click in the header field in your document. With the context
menu (Page), activate the Page Styles dialog. Select the Headers tab and click
Options. In the Borders/Background dialog, choose a background color and click
OK, then confirm the following dialog as well.
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Editing Columns

To change the number of columns or create a dividing line between columns, acti-
vate the Page Styles dialog via the Page context menu.

Click on the Columns tab. Change the number of columns in the spin box
Amount, and modify the distance between the columns in the spin box Spacing.
Make sure that the Automatic Width field is selected.

To create a dividing line, select a narrow line from the Line list box under Sepa-

rator, set the Height to 75%, and define the position as Centered. Finally, click OK
to close the dialog.

Organizer I Pagel Background | Headerl Footerl Borders Columns I Footnote I
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Separatar line

Line I 005 pt ‘I

Height 75%

Position IEentered i I
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B To place headings or subheadings that are more than a column wide into a
multi-column text, we suggest you put them in a text frame. You can freely
scale and position your text frame on the page. You can insert a frame with
the Insert Frame icon on the Insert floating toolbar. Text frames can have
borders, but do not have to.
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Editing Paragraph Styles

If you want to change the font, click the Paragraph Styles icon in the Stylist and
select the Paragraph Style you want to modify. Via the Modify command in the
context menu, call up the Paragraph Styles dialog. In this dialog, you will find
several tabs with various settings and options.

# Experiment with different font effects, for example drop caps. Click the respec-
tive tab and select Show Drop Caps. You can even assign a Style to the drop caps
in the Character Styles list box under Contents.

# A newsletter or newspaper requires a variety of main headings, subheadings,
and text wraps to make it easier to read. In the Paragraph Styles dialog of the
Stylist context menu, it would thus be a good idea to create several appropriate
Paragraph Styles ( go to the Stylist - context menu - click New...).

Working with Frames

A frame positioned over one or more columns can give the newspaper a less
crowded, more interesting appearance. Such a frame can contain text, graphics, or
even a chart.

TR EHR =S IEE=.

Click the Insert icon on the main toolbar and from the floating toolbar, select the
Insert Frame Manually icon. The mouse pointer changes to a small cross which
you use to drag open a frame and position it over one or more columns in your
document.

Formatting a Frame

Put the cursor in the frame (deselect the frame first, then click inside it) and enter
your text or graphics. The appearance and properties of the frame can, of course,
be modified at any time. Select the frame by clicking it, call up the context menu
and click Frame.... A dialog with several tabs will appear where you can, for
example, on the Borders tab, apply a colored shadow to the frame.
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Anchoring Frames

In the Frame dialog, click the Type tab and select the type of anchor under the
heading Anchor to. If the frame is to always remain on the same page - which is
important for a table of contents, for example, - select Page. If you want the frame
to flow with the text, e.g., for small symbols which always appear in the margin
accompanying a certain word in the text, select To Character. If, in flowing text,
the frame should move with the text as a character, select As Character. To anchor
a frame to a specific paragraph, select Paragraph.

= You can specify the type of anchor via the context menu. Alternatively,
click the Change Anchor icon in the Object bar to quickly change the
anchor.

Defining a Frame Wrap

To define the frame wrap, open the Frame dialog (context menu - Frame), and
click the Wrap tab. Select the desired wrap style, and under Spacing, define the
spacing between the frame and text. Finally, select the option First Paragraph.

The First Paragraph field (or the menu command in the context menu) ensures
that when a graphic is positioned between two paragraphs, only the first para-
graph wraps around the picture.

Defining a Wrap Region

If you want to make your newsletter more attractive with objects or graphics, you
can have the text flow around the object. Just draw a Polygon with the Polygon
icon in the Show Draw Functions floating toolbar. Place the polygon over the text
and assign the text the Wrap - Contour with its context menu.

You can also assign a wrap contour to 3D objects you define. Create a 3D object
with StarOffice Draw, copy it to the clipboard and paste it into the text document.
Open the context menu of the inserted object and choose Wrap - Contour.

In the context menu of an object with a wrap contour is the Wrap - Edit Contour
command. This command calls the Contour Editor where you can manually reedit
the automatic contour. Refer to the instructions in the StarOffice Help.
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Linking Frames and Facilitating Text Flow

If you want your text to be continued like in a newspaper, from a frame on page 1
to a frame on page 4, and where the text flow from frame to frame is done auto-
matically, you need to use linked frames.

Create two (or more) frames by opening the Insert floating toolbar, clicking Insert
Frame Manually), then selecting the first frame (click the border of the frame).

g@  Click the Link Frames icon on the object bar. Now, click the second frame.

To enter text in the linked frames, position the cursor in the first frame and type in
text or insert it from the clipboard.

If you want a text from a document to flow in the linked frames, first put the text
cursor in the first frame (first click the "normal” text to cancel the frame selection
and then click the frame).

Now you have to decide if you want to have the text as a copy in the frame or if it
should keep a link to the original document (in this case it would always return to
the actual stand of the original document). If the text is only to be copied, choose
the command menu Insert - File.
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If the text is a section linked to another file choose Insert - Section. In the Insert
Sections dialog that appears, click Link and select the file you want with the ...
button. Finally, click the Insert button.

Using Colored Backgrounds

To assign a colored background to a paragraph, place the cursor in that paragraph
and click the Background Color icon in the Object bar. A floating color palette will
appear from which you choose the desired color by clicking it once.

If you would like to make frequent use of a background color for a certain para-
graph, it would be best to create a Paragraph Style for this purpose.

Instead of a color background, you can have a background graphic image. The
background graphic image is assigned to a paragraph either via the Paragraph
Style (in that case, all paragraphs based on this Style will have the same graphic
background), or edit it via menu Format - Paragraph.... Click the Background tab
and in the list box As select "graphics" in order to pick out an appropriate graphic
image.

Creating a Table of Contents

A table of contents can be created manually, but if the contents are altered, the
table of contents must be manually updated, as well. It is much more convenient
(and time-saving) to have the program create a table of contents for you.

» Now that you have entered the text, you may want to create a table of contents
on the front page of your newspaper or newsletter. To do so, follow these steps:
draw a frame manually on the front page, choose To Page as anchor. Press the
Escape key to see the cursor in the frame.

= Open the Insert Index/Table dialog (choose Insert - Indexes and Tables -
Indexes and Tables). On the Index/Table tab page, select "Table of Contents"
as Type, and enter an appropriate heading, e.g., "In this issue..." in the Title
field.

If you want to create a table of contents using the headings in the document,
specify the desired outline structure using the Evaluation level spin box.

First, you have to have assigned one of the Paragraph Styles which is determined
for the chapter numbering to the headings. You can determine the Styles under
Tools - Chapter Numbering. The predefined Paragraph Styles are "Heading1"
through "Heading10".
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If you have used other Paragraph Styles of your own for the headings, you can
also incorporate these into the table of contents. To do so, go to the Insert
Index/Table dialog, click the Index/table tab and in the Create from area, mark the
Additional Styles check box. Click the button to the right of the check box. The
Assign Styles dialog will appear.
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Cancel

Frame contents
Heading Help
Heading 1

il

Heading 2
Heading 3
Table Contents
Table Heading
Text body

L

This is where you determine to which level the Style should be assigned in the
table of contents for each Style used in the document.

You can choose more settings on the Entries and Styles tab pages. Click OK to
create your table of contents.

After your newsletter is finished, you can save and print it.

Further Information

Using Automatic Hyphenation

When working with columns, it makes sense to activate automatic hyphenation for
every Paragraph Style (do so by calling up the context menu of the Stylist and
clicking Modify... to access the Paragraph Style dialog - click theText Flow tab).
Enter a "3" for Characters at line end and Characters at line begin to ensure that
hyphenated words have at least three characters at the beginning or end of a line.
For text alignment in columns, choose Justify on the Alignment tab.
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Letters With Envelopes

With StarOffice Writer, you can write a letter in no time. We will show you how
easy it is.

There are two really easy ways for you to get the result you want:

= You can use one of the many supplied letter templates, or

= use the AutoPilot to create a letter template tailored to your needs.

Using a Ready-Made Letter Template
1. Press (Shift)(Ctrl)(N) to open the Templates and Documents dialog;:

Templates and Documents - 5amples
«8| 5 £

Title

e [_ ] Drawings
] Formulas

Mew Document | | Presentations
] Spreadsheets

;i [ Text Documents

Termplates
&
My Documents
a3

Samples

Organize... | Edit: | e[ =} Cancel | Help

2. Select a template, e.g. from the Personal Correspondence and Documents cate-
gory.

3. Enter the details required for the various wildcards, such as the salutation.
Type in the remaining text.

Templates use your user data that you can enter and modify whenever you like in
Tools - Options - StarOffice - User Data.
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Creating a Letter Template Using the AutoPilot

1. To start the AutoPilot, choose File - AutoPilot. Click Letter in the submenu and
you will see the first page of the AutoPilot for Letters.

2. Select Personal Letter, and then click the button Next. A second page with
additional options appears. Choose the option No Logo, and click Next. A
dialog will appear in which you can enter the sender details.

3. You should already be able to see the sender address. Under Show sender?
select Yes. Now click the symbol top right in the Position and size area and
once again click Next.

r If the input field does not contain a sender, the program will lack the necessary
details. In this case, click Cancel, open the User Data tab (in Tools - Options -
StarOffice) and enter the necessary data. After that, you can open the AutoPilot
again and carry on as described up to this point. You can also enter your sender
details directly in the input field of the AutoPilot. But if you did not enter these
details in User Data, you will need to repeat this process for every new template
that you create with the AutoPilot.

iu'}

4. Click Next until you arrive at the page with the footer options. Deactivate the
check box Footer on and click Next twice. Now, on the page for saving the
template, type the name of the template in the Name field. If necessary, enter
any additional information in the Info field.

# The template will be stored in the template folder under the name you have
entered.

5. Again, click Next. Enter the printer trays if you want to use different paper
trays for the first and subsequent pages. This is especially practical when the
only the first page is to be on letterhead paper. The last step is to click Create.

After you click the Create button, StarOffice creates a document template and
places it in the template folder. At the same time, a new, unnamed document
appears on the screen, that has been generated as a copy from this template.

You can start to enter text and then print and save the document. However, if you
would like to keep on working on the layout of the document template or create an
envelope for it, close the new document without saving it and continue reading.
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Creating an Envelope

This section contains a description of how to create a template for an envelope
after you have completed your letter template. We will also be giving tips on how
to continue polishing the design of your template(s).

As the envelope should be saved together with its template, you should first open
the letter template.

1. Choose File - Templates - Edit. A dialog will appear in which you find the
letter template you just created and open it. The templates are found under
staroffice6.0/user/template.

2. After 